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What Is In This Manual

1. About This Manual
What Is In This Manual
This tutorial will take you step by step through the process of creating a basic database with BuildersCAD
Version 8.0. You will create a set of working drawings including framing drawings. The Tutorial is organized
into the following nine parts, each of which contains a number of chapters.

Part 1: Getting Started (Chapters 1 & 2)
An introduction to the BuildersCAD Tutorial. Read this for an overview.

Part 2: Startup (Chapter 3)
A discussion of how to start BuildersCAD (load graphics) and how the database is organized in layers
(files that are located in the database directory).

Part 3: Walls and Foundation (Chapters 4, 5, & 6)
Enter walls, place openings, dimension the floor plan. Frame walls using the default setups. Create a
foundation plan.

Part 4: Placing Parts (Symbols) (Chapter 7)
Place Parts from the Parts Application for the floor plan and electrical plan.

Part 5: Floors (Chapter 8)
Create and frame a floor system.

Part 6: Roofs (Chapter 9)
Create and frame a roof.

Part 7: Elevations (Chapter 10)
Create an elevation.

Part 8: Materials (Chapter 11)
Use the default setups to generate a material takeoff including framing materials.

Before You Begin
Before you begin working with this tutorial you should review the information in the BuildersCAD
Learning Guide. The Learning Guide provides directions on how to install and authorize
BuildersCAD on your computer. It will also familiarize you with the menu structure and view
controls.

The 3 Button Mouse
The directions presented here assume you are working with a 3 button mouse. It also assumes that the MS
Windows mouse setups you have selected will allow the mouse to function according to the “design” of
BuildersCAD. The left mouse button, F1, should pick a “non-exact” point, indicating direction. You also
use the left mouse button to select menu commands. The middle mouse button should function as an F10.
You use the middle button to exit routines and for Drag Commands (discussed later in this chapter). The
right mouse button should function as F11 and be used to pick exact database and display points (like the
corner of a wall).
Check the mouse driver settings. Set the left mouse button to click select, set the middle button to middle
button and set the right button to alternate select. If these settings are not available and you have trouble
with your mouse contact BuildersCAD Technical Support.
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How We Present Instructions
Following are the conventions used throughout this tutorial to describe the operation of BuildersCAD
Designer Applications, the BuildersCAD Framer, and the Materials Application.

Typograpical Conventions
Bold type
Prompt messages, File names, or specific keystrokes you must enter, as in enter 1’4”.
Note: The default database units in BuildersCAD is feet. If you enter the number 1 and <enter> you
are entering 1’-0”. After you enter a foot mark, BuildersCAD assumes the next number is inches.
When entering feet and inches, do not enter the dash typically seen as a separator. BuildersCAD
will interpret this as a minus sign and perform the calculation. An entry of 1’-4” will be interpreted as 8”
(1 foot minus 4 inches). Therefore instead of entering 1’-4” (with the feet, dash and inch marks) enter
1’4. The inch marks after the 4 are optional.
Names of menu buttons and menu labels.
Italic type
Highlights terms and concepts when introduced for the first time.

Keyboard Conventions
Enter, Return, <cr>
Indicates you should press the key labeled Enter or Return.
F1, F2, F3, etc.
Indicates you should press a function key. Alternatively you can use the mouse buttons if you have
the buttons set up for the required function key. The default settings for the left, middle, and right
buttons are F1, F10, and F11 respectively.

Mouse Conventions
Pick
Use the mouse to point to an entity or location on the graphics screen, and quickly press and release
either the left or right mouse button, as instructed. “Use F1 to pick ...” Means pick with the left mouse
button.
Select
Use the mouse to point to a menu item and press the left mouse button (F1) once.
Drag
Use the mouse to point to a location on the graphics screen, then hold it down as you move the
mouse.

Instructional Terms
Option
A choice on a menu or prompt line.
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Instructional Terms
Prompt
An on-screen statement that asks for a response.
Enter
Means to type letters or numbers on the keyboard, then press the Enter or Return <cr> key.

Save Your Work
Periodically you will see the following line:
SAVE THE DATABASE
When you see this line select the diskette icon in the upper left corner of the menu with the right
mouse button. This will save the database. You only want to save the database if you are
proceeding through the Tutorial without making a mistake.

If You Make A Mistake
If you make a mistake go to the BuildersCAD main menu. Select Open on the Job/Database Application
sub-menu. BuildersCAD will display the Job Database / Sheet Select pop-up menu. You will see a list of
jobs (databases) on the left side of the menu. Select pn_std.db. BuildersCAD will load pn_std.db losing
the mistake you made.
Select Open again and BuildersCAD will display the Job Database / Sheet / Thumbnail Select pop-up
menu. Select your tutorial database/job name. BuildersCAD will reload the database back to the point
when you executed the last manual Save.

The Undo Button
On the Desktop menu across the top of the screen, you will find the Undo and Redo
buttons. When Undo is selected (use the F1 mouse button) the last task or function
completed is deleted or “undone”. It is OK to use the Undo feature with most functions.
BuildersCAD will not allow you to use Undo to undo Wall Framing, Floor Framing, or Roof Framing. If you
try to use the Undo button with any of these operations, BuildersCAD will give you a warning pop-up
menu and turn off the framing layers. For additional information, see the BuildersCAD Learning Guide or
the BuildersCAD Encyclopedia.

The Mouse Motion Commands
BuildersCAD allows you to invoke commands by gesturing (moving the mouse in a
specific direction) while holding down the middle or right mouse button. The Motion
Command Interpreter menu is a menu that includes pictures of the various mouse
gestures and the default commands associated with those gestures. This is a powerful
productivity feature of BuildersCAD but requires that you learn the gestures and
associated commands.
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Mouse MCI Menu
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Figure 1-1

If you would like to learn more about the Motion Command Interpreter menu and Mouse Gestures see the
Hardware User Interface section of the BuildersCAD Learning Guide or the Motion Command
Interpreter topic in the BuildersCAD Encyclopedia.

Drawing Illustrations
Throughout this manual we will use illustrations of the BuildersCAD menus and drawing screen to better
clarify the process being described.
The default background color in BuildersCAD is black, with objects drawn on screen in various colors.
For clarity in print, in this manual we will show drawing screen figures with a white background using black
lines. Illustrations of menus an menu buttons will be shown in their original, correct, colors. On the next page
are two sample illustrations. Figure 1-2 is the drawing screen as you will actually see it in BuildersCAD.
Figure 1-3 is how the same screen will be illustrated in this manual.
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Drawing Illustrations

Figure 1-2

Figure 1-3
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2. Tutorial Overview
Introduction
The purpose of this Tutorial is to take you through the process of creating a complete materials ready
database. You can use this experience as a point of reference to develop a more in depth understanding of
how BuildersCAD works.
This tutorial is updated for use with BuildersCAD 9.1. If you have not downloaded and installed
BuildersCAD 9.1, please do so before beginning this tutorial. The software may be downloaded from the
BuildersCAD web site at www.builderscad.com in the Support section of the web site.
We need to distinguish now between a database and a materials ready database. Building a house is a
complex process and when you create a materials ready database with BuildersCAD you are essentially
building a house “in the computer”. You enter walls of a specific height and width, with rough openings for
windows and doors at the correct elevation. You generate a system of roof planes with the same geometric
properties (plane, pitch, elevation, area, etc.) as the roof on the house you build.
If you are not going to use BuildersCAD to frame the house or generate material takeoffs you can take a
different approach in creating a database. If the graphics look good and you can print the drawing then it’s
OK.
In this tutorial we will be creating a database that is materials ready, that is a database that we can use to
generate framing and material takeoffs. If you are not interested in materials output you may discover in the
process some shortcuts that will still give you the results you want.

Startup
In this section we will review how to start BuildersCAD graphics. We will also show you how to create an
empty database that you can use for this tutorial.

Walls and Foundations
We will enter walls, place openings and dimension a floor plan. Then we will use a Walls Application feature,
Foundations, that utilizes the walls you have entered to create a foundation plan. Next we will “frame” the
walls using the default framing rules.

Roof
After entering walls we will create a roof (roof plane system). You will see how BuildersCAD can generate a
roof based on information assigned to an outline around the outside of the exterior walls.
After the roof plane system is created you use the BuildersCAD Framer to generate boards on the plane
edges (such as on hip, ridge, or valley edges). After edge boards are generated the Framer can “fill” the
surface with boards of user defined size and spacing.

Floor
We will outline and create a floor plane. Floor planes may be used to frame the floor and may be used to
generate a materials takeoff. If you are not going to use the Framer or generate material takeoffs you may
not need to create floor planes.
Similar to Roofs after the floor plane system is created you use the Framer to generate boards on the plane
edges (such as end or rim edges). After edge boards are generated the Framer can “fill” the surface with
boards of user defined size and spacing.
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Placing Parts
Floor plans usually have a graphic symbol to represent plumbing fixtures, cabinets, etc. In BuildersCAD
you can select from libraries of pre-created symbols to represent plumbing fixtures, electrical symbols,
cabinets, and more. You can place these symbols in the database. BuildersCAD will store them in
separate files inside the database directory.

Elevations
BuildersCAD will automatically generate the elevation outlines with window and door symbols located
block out the elevations. You may then use existing libraries of patterns (like brick or siding) to complete the
elevation drawings.

Materials
After the design is complete and walls, openings, roofs, floors, etc. have been generated you are ready to
apply materials. You use Material application features to link specific estimating formulas to parts of the
building. The estimating formulas tell BuildersCAD what materials to use from the stock file. Then based
on geometric information available from the building you have built in the computer, material quantities are
calculated. For example, an estimating formula that calculates brick, sand, and mortar can be “applied” to
the exterior wall surface of the building.
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3. Startup Functions
Startup BuildersCAD
We will assume here that you have already installed and authorized BuildersCAD on your computer. If
you have not, see the BuildersCAD Learning Guide for directions.
After installation, if you go to the Windows Explorer you will see that BuildersCAD has created a folder
called BCAD on your hard drive. The default installation puts it on the C: drive but if BuildersCAD was
installed on another drive such as D:, the BCAD folder will be located on the same drive where the
BuildersCAD program directory was installed. Inside of BCAD you will find another folder - the graphic
user folder. The BCAD folder is parallel to the Program Files folder in the directory tree. The default
BuildersCAD program directory is a folder called BCAD91 under the Program Files directory.

Note: The default graphic user folder will be the same name as your Windows login. If you do not have
a Windows login but you assigned a name to your PC when you first installed the operating system
then the default graphic user will be the same as the machine name. If you do not have a Windows
login and you didn’t assign a name to your machine then your “default” graphics user name will be
default.

Each graphics user contains information about how walls, roofs, and floors are framed, about how materials
are estimated and graphics style information (how the drawings look) in subdirectories. This information is
unique to each graphics user and may be customized. When BuildersCAD creates a Graphics User
folder, system defaults are loaded. You can use the system defaults until you are ready to make decisions
about customizing BuildersCAD. For purposes of creating a database using this tutorial, you should use
the system default setups for all applications inside BuildersCAD.

Double Click the Graphics User shortcut icon on your desktop or select Start>>Programs>>Bcad
91>>Bcad 91 to start BuildersCAD.
The top half of the vertical menu to the right side of the screen is referred to as the Application Menu. The
lower half of the vertical menu is called the Application Sub-menu. The menu that displays horizontally
across the bottom of the screen is called the Status menu. Just above the Status menu, the horizontal row
including the Cycle button (just to the right of the Stop sign) is the User Toolbar. Messages will frequently
appear on the Prompt Line, just above and to the left end of the User Toolbar. Pop-up menus appear over
the drawing area. For more information on the menu structure, refer to the BuildersCAD Learning
Guide.
When you first load BuildersCAD you will notice that a database called pn_std is loaded. You can see the
database that is loaded by looking on the Status menu under the heading Job/Database. In the Windows
Explorer you can see this database folder as a sub-folder called pn_std.db that is located inside the
graphics user folder.

The BuildersCAD starting screen and menu system is shown in figure 3-1 on the next page.
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Figure 3-1

Load the Tutorial Database
You can start a new database (or job) in BuildersCAD by saving the default database (pn_std) as a new
name or by selecting the New button on the Job/Database Application sub-menu. For the tutorial we have
already created an empty database called tutorial in your graphic user folder.
To load the tutorial database: on the Application menu, under Job/Database select Open.
The Job Database/Sheet/Thumbnail Select pop-up menu will display. See figure 3-2 on the next page.
Looking down the column on the left side of the menu select the box containing tutorial.db.
Next, you will see a box in the upper left of the matrix on the right side of the menu. The text master.dr
appears in the box. Select this box with your left mouse button. The box will highlight. Finally select the
Open button at the bottom right of the Job / Database / Sheet / Thumbnail Select pop-up menu.
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Load the Tutorial Database
1. Select the box containing
tutorial.db on the left side of
the Job / Database / Sheet /
Thumbnail Select menu.

C:\bcad\jlb
pn_std.db

Job / Database / Sheet / Thumbnail Select
Name
Description

pn_std.db
tutorial.db
noname.db
global.icg
pn_std.wf
config.dir

Drawing
Sheet

master.dr

2. Select the master.dr box on
the right side of the Job /
Database / Sheet / Thumbnail
Select menu.

3. Select the Open box at the
bottom of the Job / Database
/ Sheet / Thumbnail Select
menu.

Plot

Briefcase

Preview

Open

Exit

Figure 3-2

The database tutorial.db will begin to load. When loading is complete the entry under Job on the Status
menu will change to tutorial.
When the database has loaded you will see a rectangle displayed on the display window. This is an 8 ½ x 11
outline at 1/4”=1’-0” scale. You will be drawing the Tutorial at 1/4” scale and you can plot or print what you
draw on 8 ½ x 11 paper as long as what you draw is within the sheet outline displayed.
The sheet outline (4 lines) are on layer zero (0) and may be turned off at any time through the Layer Menu.
Note: As you draw or enter data in a database, entities will be created in layers in the database. In the
Windows Explorer you can see these layers as files that are located inside the database directory.
BuildersCAD manages the layers in a database, creating layers as needed. It will automatically
place walls, dimensions, text, etc. In the correct layers where they need to go in the database. It is
very important to let BuildersCAD manage the layers for you because later when you want to frame
or apply materials to a design, the Materials Application will expect to find certain entities on certain
layers. The way BuildersCAD manages layers will also make the task of printing or plotting easier
because you will be able to “turn on” only the layers you want to print and therefore have control of
what entities you print or plot.
Note: BuildersCAD will put database entities on layers numbering from 1001 to 32,000. The first
1000 layers are left open for use by the user.

You are now ready to begin entering your building in the tutorial.
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4. Entering Walls and Openings
The Core of the Database
Walls are the core of the BuildersCAD database. They are used as a pattern to generate the Foundation
Plan. The roof outline is usually defined by the exterior walls. Therefore it is critical for the wall layout to be
correct, which means the correct length walls, a “square” layout, etc. Also, because the of the
BuildersCAD Framer and the Materials Application the walls must be the correct height.

Before You Start The Wall Layout
Before beginning the wall layout, from the User Tool Bar menu, select the Layer Menu icon.
The Layer pop-up menu allows you to turn layers on and off for Edit, Search, and/or Display.

1
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RW
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All
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Figure 4-1

Note: From this point forward if you are directed to select a button or pick a point without specific
direction on which mouse button to use, you should use the F1 button (left mouse button).
Under the column heading Modes you see 5 columns. The first is the work layer (WK) column. The layer you
are currently working on is the work layer. The (WK) button will be highlighted for the current working layer.
The column all the way to the right indicates which layers are turned OFF. If the OFF button is highlighted
then you will not see the layer. The other 3 columns determine if a layer is Editable, Searchable, and
Displayable. If a layer is on for Edit, commands you execute will affect the entities on that layer. If a layer is
on for Search, but not edit then you may select entities on that layer for reference purposes but you cannot
edit them. If a layer is on for Display only then you can see the layer on the screen but cannot select or edit
entities on that layer.
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Select the S to turn on layer number 0 for select and display using the F1 key or left mouse button.
This is the layer with the sheet outline. You will see pre-created layer numbers 0. 1001, 1002, 2001, 2002,
3001, 3002, 4001, 4002, 5001, and 5002. Except for layer 0 these are the working walls layers for walls on
levels A, B, C, D, and E. Whether or not these are pre-created, BuildersCAD will create the layers it needs
as you enter the work.
After you have turned on layer 0 for search and display, select: Exit and Display at the bottom right of the
Layer Menu.
At the bottom right corner of the screen, above the Cycle menu is the View Control Bar. Here there are 11
icons that control the view of the screen. Following is a picture of each icon with a brief description of what it
does. The view controls are described more fully in the View Control Bar section of the BuildersCAD
Learning Guide, and in the Display, View, and View Control Bar topics in the BuildersCAD
Encyclopedia.
Dynamic Pan - Pans the current view around the drawing. Left Click, hold and drag the cursor
to move around the drawing.
Dynamic Zoom - Zooms the current view dynamically. Left Click, hold and move the cursor Up
to zoom in and Down to zoom out.
Zoom Window - Zooms the display to a window defined by two opposite corner points.
Zoom In - Zooms the display in (larger) by a pre-set factor. The zoom factor is set on the View
menu.
Zoom Out - Zooms the display out (smaller) by a pre-set factor. The zoom factor is set on the
View menu.
Zoom All - Displays all entities on all layers turned on for display as large as possible.
Plan View - Sets the view to plan (top) view and displays all entities on all displayable layers as
large as possible.
Isometric View - Sets the view to isometric and displays all entities on all displayable layers as
large as possible.
Re-Display - Refreshes the screen keeping the current zoom window and view.
View Menu - Displays the View pop-up menu which contains more view orientation options
including front, rear, left, right, inverted, and perspective views.
eZ 2D - If eZ from Sigma Design is installed, this button opens the current 2D drawing into eZ. If
eZ is not installed, the current 2D drawing is opened in eZView.
eZ 3D - If eZ from Sigma Design is installed, this button opens the current 3D model into eZ. If
eZ is not installed, the current 3D model is opened in eZView.
Use these icons to move around or change views of the display window.
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The Wall Layout
In addition to the View Control Icons you can change views of the display window by using
commands available on the User Tool Bar. If you select the Cycle button on the User Toolbar
you will see the command selection buttons on the toolbar change. This menu changes or
“cycles” as you repeatedly select the Cycle button.
There are two sets of commands on 2 different “Cycle Bars” shown in figures 4-2 and 4-3 below. On Cycle
bar #1 (figure 4-2 below) you will find the commands MOVE AREA or POINT, QUERY DIST (distance), REF
(reference point) NEW or DBL (double), etc. For more information on the Cycle menus, refer to the Cycle
Menu section of the Special Menus topic in the BuildersCAD Learning Guide, and the Cycle Menu
topic in the BuildersCAD Encyclopedia.
Move
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1002
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Figure 4-3

At this point you should see only the sheet layout on your screen.

The Wall Layout
Under BuildersCAD on the BuildersCAD Main Application menu:
Select: Walls
This will generate the WALLS Application menu and the Place Walls Application sub-menu. You will also
see a new Status menu that tells you the current JOB, what LEVEL you are on, and the wall HEIGHT and
WIDTH, and other information.

SELECT

We want to start the wall layout by entering exterior walls. Select the button at the
top of the Place Walls Application sub-menu, SELECT.

This will display the WALL Select pop-up menu. This menu is shown in figure 4-4 on the next page.
Walls are sorted by Type. Wall Types are shown in a column on the left side of the WALL Select pop-up
menu. Select the EXTLB (Exterior Load bearing) wall type and then select the wall number 1 in the matrix
on the right side of the WALL Select pop-up menu.
After you select this wall your selection should be reflected in the display on the Status menu across the
bottom of the screen. To clear the WALL Select menu,
Select: EXIT at the bottom right of the WALL Select menu.
Note: Before beginning entering the wall layout look on the Status menu in the bottom left corner of
the screen. Notice the box under the Rel label. By selecting on this box it will toggle from on to off.
Make sure it is set to on. Also if the 8 ½ x 11 sheet is not displayed you might want to go back to the
Layer Menu and turn it on so you can start the wall layout near the lower left corner of the sheet.
Leave room for dimensions that will be added later.
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1. Select the EXTLB
box on the left side
of the WALL Select
menu.

2. Select wall type
number 1 from the
matrix on the right
side of the WALL
Select menu.

Catalog
Type

BuildersCAD Catalog
EXTLB - EXTERIOR LOAD BEARING

EXTLB - EXTERIOR LOAD BEARING
EXTNLB - EXTERIOR NON-LOAD BEARING
INTLB - INTERIOR LOAD BEARING
INTNLB - INTERIOR NON-LOAD BEARING
CONCRETE
STEEL
RFRNC - REINFORCED CONCRETE
BEAM

WALL Select
Wall Number
Size

Rule Set
Load From project

1

2

3

4

5

6

7

8

9

10

11

12

3. Select Exit at the
bottom of the WALL
Select menu to
clear the menu
from the screen.

Create

Edit

Place

Exit

Figure 4-4

On the Place Walls Application sub-menu,
Select: CCW
This means you should layout exterior walls in a counterclockwise direction.
Note: Counterclockwise is the common choice in CAD drawings because the rotation angle is always
positive. This will also help organize your walls by keeping the “sheathing side” or front to the outside
of the building and the “drywall side” or back side to the inside.
To begin wall entry,
Select: DRAG on the Place Walls Application sub-menu.

DRAG

Prompt: First point of wall (F10 to cancel):
Select: New under Ref on the Cycle menu.
Prompt: New reference point:
With the right mouse button pick the lower left corner of the sheet outline.
Prompt: First point of wall (F10 to cancel):
Enter: 7,7 <cr>
The cursor will jump to a point inside the sheet outline. Moving the mouse to the right will cause a red double
line to stretch behind it.
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Move to the right until the distance register equals 30’-0”. This register appears on the Prompt Line.
Note: You can move the mouse up or down as you move it to the right and the register will display
degrees measured from the horizontal, counter-clockwise. Here you want the wall to be horizontal, or
zero degrees.
Once 30’ has been achieved, press F1. This will display the Wall
Input pop-up menu (figure 4-5) with many new choices on it. By
selecting the Place Wall button on this menu, the 30’ wall will be
entered, the word OUT will appear below the first wall and the
cursor will be free to move again.

Wall Input
Mode
Drag

Angle

Input XY

Dbl Ref

00.00

Off

Calculator

Move the cursor toward the top of the screen (at 90 degrees) until
the distance reaches 20’-0”.
Press F1 / left mouse button.
Select: Place Wall
Note: You have noticed that this input technique moves in
even 1’-0” increments. To move to a specific inch or fraction,
select the Feet, Inch, & Fraction buttons located in the middle
of the menu. The selected wall length will be displayed on the
menu and on the message line at the bottom of the screen.
Select the Place Wall option to input the wall.
Now move the cursor toward the left (any distance, at 180 degrees)
and press F1 with your mouse. What we want to do is match the
back left wall corner to the left front wall corner. The best way to
accomplish this is to select the Double Reference button near the
upper left corner of the Wall Input pop-up menu.

Clear

Distance: 30’-0” Angle: 0.00
Feet

Inch

0
2

1

4

5
7

6
8

3

9

Fraction
1/16

3

0
1/8

5
7

1/4
3/8

5/16
7/16

9

1/2

9/16

11

5/8

11/16

3/4
7/8

13/16
15/16

0
2

1

4
6
8
10

3/16

Placement
Stop

Create
Closure

Undo
Wall

Place
Wall

Figure 4-5

Prompt: Select double reference point:
Move the mouse to place the cursor over the lower left corner of the first wall and press the right mouse
button. This will use the F11 to “snap” to the end of that wall. The wall length will now equal that of the front
wall, 30’-0”. Select Place Wall on the Wall Input pop-up menu.
Next move the cursor toward the first wall (at any degree) and press F1 with your mouse. The command we
need now is on the Wall Input pop-up menu.
Select: Create Closure
This will automatically “close” the exterior walls and terminate the Drag wall input session.
Note: It is important that the last wall is created with the Create Closure command so that the system
can properly locate and draw the corner, thereby also adding the proper corner framing condition.
You have now created a simple 30’ x 20’ rectangular structure.
We now want to SAVE THE DATABASE. If you do not remember how to do this see Chapter 1 of this
Tutorial.
When you enter walls with BuildersCAD you are entering wall panels. The system is determining panel
laps as you enter the walls. If you want to change the laps there are tools on the Edit Walls Application submenu. Select on Edit Walls at the bottom of the Place Walls Application sub-menu to display the Edit Walls
sub-menu. At the bottom of the menu there are two icons. The one to the left shows a standard lap and the
one to the right shows a mitered lap or intersection. These are shown in Figure 4-6.
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Standard Lap

Mitered Lap
Figure 4-6

On the Edit Walls Application sub-menu:
Select: Standard Lap icon
Prompt: Select wall to change (F10 Cancel):
Pick point at a corner using the left mouse button. The wall nearest the pick will be the wall which laps over
the other wall in the intersection. Try selecting each of the corners and changing the lap until the laps are like
those in Figure 4-7.

Figure 4-6

We are leaving the laps set so that the two end walls (running vertically on the display window) extend to the
outer corners of the structure.
We have now completed entry of exterior walls. SAVE THE DATABASE.
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Next we will enter interior load bearing walls. At the bottom of the Edit Walls Application sub-menu select on
Place Walls to flip back to the Place Walls Application sub-menu.
Select: the SELECT button
This displays the WALL Select pop-up menu. On the left column listing Wall Types:
Select: INTLB (interior load bearing), then select wall 1 in the matrix (that is 3 1/2” in width), then Exit.
On the Place Walls Application sub-menu, under the Insert heading:
Select: Reference Point icon.
Prompt: Select wall near end (F10 Cancel):
With the F1 button select a point near the end of the bottom, horizontal wall, but inside the structure.

Pick point here.

Figure 4-7

The wall will highlight and an X will appear on the left inside corner.
Prompt: Enter Option? DRAG NEW REFERENCE CALC MENU 1’ 2’ 3’ 4’ 5’ 2’1” 3’1” 3’7” OTHER
Enter: 7’5 <cr>
The X will jump 7’-5” down the wall.
Prompt: Wall Length? AUTO-EXTEND DRAG MAN-EXTEND DBL-REF CALC MENU CANCEL
OTHER
Select: AUTO-EXTEND
The wall will extend across the room until it intersects the opposite wall.
Prompt: Select a wall near the end (F10 Cancel):
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With the F1 button select a point near the upper end of the wall you just entered but to the left side.

Pick point here.

Figure 4-8

Prompt: Enter Option? DRAG NEW REFERENCE CALC MENU 1’ 2’ 3’ 4’ 5’ 2’1” 3’1” 3’7” OTHER
Enter: 8 <cr>
This measures 8’ down the wall. After the X jumps into position,
Prompt: Wall Length? AUTO-EXTEND DRAG MAN-EXTEND DBL-REF CALC MENU CANCEL
OTHER
Select: AUTO-EXTEND
This enters a horizontal wall.
Select the same point near the end of the same vertical wall.
Prompt: Enter Option? DRAG NEW REFERENCE CALC MENU 1’ 2’ 3’ 4’ 5’ 2’1” 3’1” 3’7” OTHER
Enter: 2’2.5 <cr?
This references a wall starting point 2’ 2 1/2” down from the top horizontal wall.
Prompt: Wall Length? AUTO-EXTEND DRAG MAN-EXTEND DBL-REF CALC MENU CANCEL
OTHER
Enter: 2.5 <cr>
This inserts a 2’ 5” horizontal wall. From the Place Walls Application sub-menu, under the Insert heading,
Select: Insert From Near Face icon
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Prompt: Select wall near end (F10 Cancel):
You want to insert a wall off of the short horizontal wall you just entered by picking a point (with the F1 button)
near the free standing end but closer to the exterior wall.

Pick point here.

Figure 4-9

Prompt: Wall Length? AUTO-EXTEND DRAG MAN-EXTEND DBL-REF CALC MENU CANCEL
OTHER
Select: AUTO-EXTEND
Select: the Stop sign button on the User Tool Bar to terminate wall entry.

Stop

Interior wall entry is now complete. SAVE THE DATABASE.

Because we are going to put a gable roof on this structure we need to “rake” both end walls; that is slope the
top plate upward so the wall will fill the space under the gable roof on each end of the structure.
Select: the wall at the right end of the structure.

Wall # 2 on Level A

This will cause a wall specific edit pop-up menu to display as shown in
Figure 4-10.
Select: The Alter Wall button.
The Alter Wall pop-up menu (Figure 4-11) will display.

Alter
Wall
Pen
Figure 4-10
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Alter Wall
Wall No
A-0

Symbol

Wall Height
Left

8’- 1 1/8”

Right

8’- 1 1/8”
Wall Rakes

Left

0 / 12

Right

0 / 12
Wall Base

Wall Functions
Wall
Data

Hgt/Rake
Changes

Override
Functions

Offset

0’-0”

Rake

0 / 12

Select Another Wall

Opening
Changes

3D
Frame

Custom
Frame

From
Screen

Wall
Number

Figure 4-11

Along the bottom of the Alter Wall pop-up menu under the Wall Functions heading select on Hgt/Rake
Changes. The right side of the pop-up menu will change. Select on the boxes under Wall Rakes, Left and
Right and change the rake on both sides to 8/12. You will be able to pick the 8 from a Choice menu at the
prompt. We will be putting an 8/12 rake gable roof on this structure.
After you have changed this wall select the button From Screen under the Select Another Wall heading in
the bottom right corner of the menu. Select and change the rakes on the other end wall. When this is
complete select the “X” box in the very top right corner of the Alter Wall pop-up menu to clear the menu from
the screen.
SAVE THE DATABASE.
You have completed and saved the wall entry and should have a floor plan as shown in Figure 4-12.

Figure 4-12
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Insert Doors and Windows
You are now ready to insert Openings. When you insert an opening with BuildersCAD you are inserting
the rough opening for the window or door in a wall panel. Every opening in the Opening Libraries has a
width, height, and header height established. These parameters are editable on the OPENING Select
menu.
We will start with Exterior Doors. On the WALLS Application menu,
Select: Place Openings.
This will display the Place Openings Application sub-menu. On this menu select the SELECT button. This
will display the OPENING Select pop-up menu, shown in Figure 4-13 below.

Catalog
Type

BuildersCAD Catalog
EXTERIOR DOOR

EXTERIOR DOOR
INTERIOR DOOR
BEAM POCKET
WINDOW 1
WINDOW 2
WINDOW 3
WINDOW 4
WINDOW 5

OPENING Select
Opening Name
Description

30EXT
3068 Exterior Door

Sub Comp No

120HD

160HD

28EXT

28EXT1sl

28EXT2sl

30EXT

30EXT1sl

30EXT2sl

30EXTx2

60SGD

80HD

Create

Edit

Place

Exit

Figure 4-13

The various opening types are listed on the left side of the menu. When one of these types is selected, the
right side of the menu displays either a list or a matrix showing the names and images of openings of the
selected type.
The various opening types are listed on the left side of the menu. When one of these types is selected, the
right side of the menu displays either a list or a matrix showing the names and images of openings of the
selected type. On the OPENING Select menu, under the opening type column,
Select: EXTERIOR DOOR.
The matrix on the right side of the OPENING Select menu will change to display the exterior doors.
Select: 30EXT on the right side of the OPENING Select pop-up menu.

BuildersCAD Tutorial

23

4. Entering Walls and Openings
Select: Exit at the bottom right of the OPENING Select pop-up menu.
We want to insert the door we have selected in a location measured off of the lower left hand corner of the
structure. On the Place Openings Application sub-menu under the Place heading,
Select: Ref Pt.
Prompt: Enter reference point (F10 options)
On the outside of the floor plan, at the bottom to the left of the vertical wall, pick the bottom outside corner of
the wall with the F11/right mouse button. A white X will appear on the corner.
Prompt: Select wall for opening (F10 options).
We will now select the wall to put the door in. At any point on the bottom horizontal wall, between the interior
and exterior wall, pick a point on the wall with the F1 button. This places a marker for measurement. Two
“arrows” appear, one points to the left and has a negative sign (-), the other points to the right and has a
positive sign (+). See Figure 4-14 below. Because we are working in the bottom left corner of the plan you
may only be able to see the (-) negative arrow, the other being obscured by the wall.

Figure 4-14

Prompt: Distance (+) or (-) -12” -5.5” -3.5” 3.5” 5.5” 12” OTHER
We will now enter the distance measurement from the corner to the opening.
Enter: 5’6 <cr>
You will see 3 vertical bars appear on the wall you selected for the opening. See Figure 4-15. These 3 bars
represent the Left Jamb, Center, and Right Jamb of the opening.
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Figure 4-15

Prompt: Select bar to align on reference point.
The dimension you entered is to the center of the opening so pick the center bar with the F1 key. The door
will be inserted in the wall, highlighted in red, with the door swinging in, hinged on the right side of the
opening.
Prompt: PLACE? DEF: PLACE REV HAND REV SWING MOVE EDIT UNDO
Reverse the hand or swing by selecting the appropriate box on the Choice menu above the prompt line.
Use these options until the door appears as shown in Figure 4-16 below. When the hand and swing are
correct, select the PLACE option for the prompt on the Choice menu. The color of the door on the screen
will change to white and it will be placed in the wall.

Figure 4-16
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Now let’s insert two garage doors. On the Place Openings Application sub-menu, select the SELECT
button. This will display the OPENING Select pop-up menu.
Select: EXTERIOR DOOR on the opening types list on the left side of the OPENING Select menu.
Select: 80HD in the matrix on the right side of the OPENING Select menu.
Select: Exit at the bottom right of the OPENING Select menu to clear the menu from the screen.
Select: Multiple under the Place heading on the Place Openings Application sub-menu
This brings up the Multiple Placement Method Selection pop-up menu shown in Figure 4-17 below.

Multiple Placement Method Selection

eq

eq

eq

eq

1

2

eq

eq

eq

eq

1

2

offset

dist

dist

dist

dist

1
offset
1

Figure 4-17

Select the placement method shown second from the top. This will place openings with equal spaces from
the wall end point to rough opening edge and between rough opening edges.
Prompt: Enter number of openings? 1 2 3 4 5 6 OTHER
From the choice menu above the prompt line select 2.
Prompt: Select start point (F10 reset):
Pick the upper right corner of the building layout using the F11 key / right mouse button.
Prompt: Select end point (F10 reset):
Pick the lower right corner of the wall layout using the F11 key / right mouse button. Two (2) Garage Doors
will be inserted, as shown in Figure 4-18 on the next page.
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Figure 4-18

SAVE THE DATABASE
You have completed insertion of exterior doors and saved the database, and should have a floor plan as
shown in Figure 4-18 above.

We are now ready to insert interior doors. On the Place Openings Application sub-menu select the
SELECT button. This will display the OPENING Select pop-up menu.
Select: INTERIOR DOOR on the opening types list on the left side of the OPENING Select menu.
Select: 28INT in the matrix on the right side of the OPENING Select menu.
Select: Exit at the bottom right of the OPENING Select menu to clear the menu from the screen.
Select: Int - Casing (Intersection minus casing) under the Place heading on the Place Walls
Application sub-menu.
Prompt: Select wall for opening (F10 options):
On the interior vertical wall, below the interior horizontal wall, intersecting at approximately the middle, pick
a point on the wall with the F1 button.
Prompt: Select intersecting wall (F10 for options):
With the F1 button select the interior horizontal wall intersecting near the middle of the wall. See Figure 4-19
on the next page. An opening will appear in the wall. The opening will be located in the wall with the Jamb 3”
from the intersecting wall to allow for jamb framing. This distance is set and displayed on the Status menu in
the lower right corner of the screen.
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Point 2

Point 1

Figure 4-19

Prompt: PLACE? DEF: PLACE REV HAND REV SWING MOVE EDIT UNDO
You may need to reverse the swing or the hand of the door similar to the process for exterior doors, until the
door looks like Figure 4-20. When the door is shown on the screen correctly, select Place on the Choice
menu for the prompt.

Figure 4-20

Prompt: Select wall for opening (F10 options):
On the Place Openings Application sub-menu, select End - Casing.
Prompt: Select wall near end (F10 options):
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Select the interior horizontal wall toward the right end. The door will appear in the wall.
Prompt: PLACE? DEF: PLACE REV HAND REV SWING MOVE EDIT UNDO
Reverse the hand or swing as needed by selecting the appropriate choice on the Choice menu above the
prompt until the door appears as shown in figure 4-21 below. Select Place on the Choice menu to place the
door.

Figure 4-21

We are now ready to insert windows. On the Place Openings Application sub-menu, select the SELECT
button to display the OPENING Select pop-up menu.
Select: Window 1 on the opening types list on the left side of the OPENING Select menu.
Select: 2646DH in the matrix on the right side of the OPENING Select menu.
Select: Exit at the bottom right of the OPENING Select menu to clear the menu from the screen.
Select: Multiple under the Place heading on the Place Walls Application sub-menu.
This will display the Multiple Placement Method Selection pop-up menu. See Figure 4-17 on page 26.
Select the placement method shown second from the top. This will place the openings with equal spaces
from the wall end point to the rough opening edge and between rough opening edges.
Prompt: Enter number of openings? 1 2 3 4 5 6 OTHER
From the choice menu above the prompt line select 2.
Prompt: Select start point (F10 reset):
Pick the interior of two wall intersections with the F11/right mouse button as shown in Figure 4-22 for the
start point and end point.
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Pick points here

Figure 4-22

Two 2646DH windows will go into the wall at equal spacing. We will now nsert two (2) 2646DH windows in
the opposite wall using the same process.
Select: Multiple under the Place heading on the Place Walls Application sub-menu.
This will display the Multiple Placement Method Selection pop-up menu. See Figure 4-17 on page 26.
Select the placement method shown second from the top. This will place the openings with equal spaces
from the wall end point to the rough opening edge and between rough opening edges.
Prompt: Enter number of openings? 1 2 3 4 5 6 OTHER
From the choice menu above the prompt line select 2.
Prompt: Select start point (F10 reset):
Pick the interior of two wall intersections with the F11/right mouse button as before on the opposite wall for
the start point and end point. The two windows will be inserted into the wall. We will place one more 2646DH
window.
Select: Point under the Place heading on the Place Walls Application sub-menu.
Prompt: Enter point for opening (F10 options):
On the Cycle menu, under the Ref heading,
Select: New
Prompt: New reference point:
Pick the outside lower left corner of the floor plan with the F11/right mouse button. A white “X” will appear on
the corner.
Prompt: Enter point for opening (F10 options):
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Enter: ,5 <cr> (a direction 5’-0” up in the positive Y axis)
The opening will appear in the wall highlighted.
Prompt: PLACE? DEF: PLACE REV HAND REV SWING MOVE EDIT UNDO
Select: Place
The wall layout with windows and doors should look like Figure 4-23 below.

Figure 4-23

SAVE THE DATABASE.
You have completed input of openings and saved the database, and should have a floor plan as shown in
Figure 4-23 above.

We will now label the openings. On the Place Openings Application sub-menu,
Select: Label Openings icon
DH3636

The Label Openings pop-up menu will display. See Figure 4-24 on the next page. On the Label Openings
pop-up menu, be sure the following parameters are set:
Search Mode is set to All
Text Size is set to 1/8”
Window Placement is set to INSIDE
Under the Command Execution heading on the Label Openings pop-up menu:
Select: Create Labels
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Label Openings
Area
in

Single
2. Set Text Size to 1/8”

3. Set Window
Placement to INSIDE.

Level

A

Search Mode

1. Set Search Mode
to All.

Area
out

All

Label Parameters
Text
Size

0 1/8”

Color

17

Clear
Layer

Yes

Window
Placement

INSIDE

Command Execution

4. Select Create
Labels.

Create Labels

Figure 4-24

When you have completed this task the floor plan should look like Figure 4-25.

Figure 4-25

The wall, door, and window layout are complete.
SAVE THE DATABASE
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Frame the Walls
BuildersCAD will utilize Wall Framing Rules to frame the wall layout. The Wall Framing Rules will
determine the stud spacing, header size, how walls will be framed at intersections, etc. The default wall
framing project, pn_std.wf, loads when you load BuildersCAD. This is the rule set we will use to frame the
walls you have entered. For additional information on Wall Framing Rules see the Wall Framing Rules
section of the Walls Application topic in the BuildersCAD Encyclopedia.
Note: If you only want wall panel drawings from BuildersCAD you don’t need to add dimensions,
notes, or other details to the wall layout. You can frame the walls and generate panel drawings as
soon as the wall layout is complete.
Select: Wall Framing on the Walls Application menu to display the Wall Framing Application submenu.
Select: The Framer icon.

FRAMER

This will display the Framing Data pop-up menu as shown in Figure 4-26. You can generate framing data
or remove existing framing data from this menu.
Framing Data
Wall Levels
All

A

B

C

D

E

Generate
Framing Data

F

G

H

I

J

Remove Existing
Framing Data
Figure 4-26

Select: A under the Wall Level heading on the Framing Data pop-up menu.
Select: Generate Framing Data on the Framing Data pop-up menu.
Prompt: Framing Alert:? DEF: VIEW FILE PRINT FILE IGNORE
Select: IGNORE
Note: The Framer expects to have at least 3 1/2” from the edge of an opening to the edge of the wall
panel or an intersecting wall. Since there is less than 3 1/2” from the edge of some of the interior doors
to the edge of an intersecting wall, the Framer generates an error message.

View the 3D Boards
It is not necessary to generate the 3D boards before you generate Wall Panel Elevation drawings or run a
Pull List. You may however want to view the 3D boards as a means of verifying how the walls are framed.
Select: The Display icon on the Wall Framing Application sub-menu.

DISPLAY

This will display the Display Wall Boards pop-up menu. This menu is split into two sections. The left side
has parameters that affect 3D Boards display and the right side has parameters that affect display of a 2D
Sheathing Layout. This menu is shown in Figure 4-27.
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Display Wall Boards

Level

3-D Boards

A

2-D Sheathing Layout

Display
3D Boards

YES

Display
Inside Sheathing

YES

Display
Inside Sheathing

NO

Display
Outside Sheathing

YES

Display
Outside Sheathing

NO

Use Temporary
Layer

YES

Create Shadeable
Boards

YES

Create
3-D Boards

Create
2-D Sheathing
Figure 4-27

Set the 3-D Boards parameters as indicated below.
Display 3-D Boards should be set to YES.
Display Inside Sheathing should be set to NO.
Display Outside Sheathing should be set to NO.
Use Temporary Layer should be set to YES.
Create Shadeable Boards should be set to YES.
After the parameters have been modified,
Select: Create 3-D Boards on the Display Wall Boards pop-up menu.
BuildersCAD will generate the 3D boards. After they are generated, select the Iso View
display button on the View Control Bar. The boards should look like the image in Figure 4-28.

Figure 4-28
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Use the tools on the View Control Bar to review the 3D Boards.
Select: Place Walls at the top of the Walls Application Main menu to turn off the 3D Boards display.
Select: The Plan View icon to return the view to plan.

Panel Elevation Drawings
Now that walls and openings are entered and the building has been framed, we will create a Panel Elevation
Drawing of one of the wall panels.
Select: Wall Framing on the Walls Application Main menu.
This will display the Wall Framing Application sub-menu.
Select: The Panel Elevation Drawings icon.
The Wall Drawing Options pop-up menu will display. This menu is shown in Figure 4-29. We will not modify
settings here but for more information on the settings shown, refer to the Wall Framing section in the Walls
Application topic of the BuildersCAD Encyclopedia.

Wall Drawing Options
Drawing Parameter Selection
Border
Setup

Dmns
Layout

Dmns
Setup

Label
Layout

Drawing
Layout

Dimension Layout
Opening

OFF

Subassembly
Opening Width

ON

LEFT
OFF

Opening Height

ON

OFF

Overall Top

ON
ON

OFF

Overall Bottom
Overall Sides

OFF
LEFT

ON

Angled
Slope Symbol
Dimension From

OFF
RISE/RUN
LEFT

Wall Selection
All
Walls

Single
Level

Single
Wall

Output Selection
Plot

Drawing

View

Figure 4-29
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Select: Single Wall under the Wall Selection heading on the Wall Drawing Options pop-up menu.
Select: Drawing under the Output Selection heading on the Wall Drawing Options pop-up menu.
Prompt: Make drawing layer temporary? yes no
Select: no
Tip: By selecting no the Wall Panel Elevation Drawing you generate will be saved in the database. If
you select yes, when you save the database and close BuildersCAD the Wall Panel Elevation
Drawing layer will be deleted automatically.
Prompt: Select wall to draw (F10 to Cancel):
Using the left mouse button (F1) pick the wall with the garage doors. BuildersCAD will generate a Wall
Panel Elevation Drawing like the one shown in Figure 4-30.

Figure 4-30

Prompt: Enter Choice: Continue Cancel
Select: Cancel
The wall layout will display again.
We have now framed the walls, viewed the 3D boards, and generated a Wall Panel Elevation Drawing. In
the next chapter we will dimension the floor plan.
SAVE THE DATABASE.
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5. Walls - Dimensions and Text
Dimensioning Walls vs Dimensioning the Floor Plan
BuildersCAD creates a layer specifically for the dimensions associated with walls (a separate layer for
each level of walls). BuildersCAD will also create a layer for dimensioning associated with other
applications such as Parts, Foundations, etc. Typically the wall dimensions will be used and displayed as
the dimensions for the floor plan.

Manual vs. Global Dimensioning
There are manual dimensioning tools available under drawing tools in each Application. In the
Walls Application, there are additional dimensioning tools called Global Dimensions. Select
Drawing Tools on the Walls Application menu. This will display the Drawing Tools pop-up
menu. On this menu you will see the Dimension icon, which accesses manual dimensioning
tools, and Global which accesses the Global Dimensioning tools. For dimensioning the floor
plan, you will probably find the tools available under Global make dimensioning faster and
easier.

Dimensioning the Floor Plan
To begin dimensioning the tutorial database, make sure you are in the WALLS Application and
layers associated with Level A (1001, 1002, etc.) are on for edit, search, and display (on the
Layer menu). On the Status menu you should see tutorial displayed under Job, and A
displayed under Level.
To access Global Wall Dimensioning,
Select: Drawing Tools on the Walls Application menu.
This will display the Drawing Tools pop-up menu as shown in figure 5-1.
Drawing Tools
Walls
Level
A
Draw

Notation
NOTE
12
A1

Misc
Labels

User
Defined
Labels

Dimensions
Global

Select the Global Wall
Dimension button.

Figure 5-1
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Select: Global under the Dimensions heading on the Drawing Tools pop-up menu.
This will display the Global Wall Dimensioning pop-up menu, shown in Figure 5-2 below.
Global Wall Dimensioning

Wall Level

Edit
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Place

Flip
Side

Merge

Witness
Offset
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Insert
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Global Dmn

Setup
Auto Dmn

Wall
Direction

Use
Current

Figure 5-2

Select: Setup Global Dmn on the Global Wall Dimensioning pop-up menu.
This will display the Global Wall Dimensioning Setup pop-up menu, shown in Figure 5-3.
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The top portion of the pop-up menu consists of a diagram that depicts a wall layout including a wall opening
and an intersecting interior wall. There are boxes below the diagram that enable you to determine how walls
and openings will be dimensioned. If a box is highlighted then the corresponding point will be dimensioned.
For example by selecting on the appropriate box you can cause BuildersCAD to dimension to the
outside, center, or inside of exterior or outside walls. The same applies to interior intersecting walls and
openings. You can use BuildersCAD to dimension to either the outside corner, the inside corner or the
center.
To begin dimensioning turn off the INT. WALL buttons directly below the intersecting wall diagram. To do
this:
Select: INT. WALL highlighted buttons.
All interior wall buttons should now be gray. BEG. WALL, OPENING, and END WALL buttons should be
highlighted as shown in Figure 5-3.
Along the left side of the Global Wall Dimensioning pop-up menu there are other dimension parameters to
set. Under Dimension Side:
Select: Outside
Select: The box next to Dimension Offset.
Prompt: Offset distance for dimension:
Enter: 2 <cr>
The Overall Dimension setting toggles from YES to NO. This should be set to YES.
Select: The box next to Overall Dimension Offset.
Prompt: Offset distance for overall dimensions:
Enter: 3 <cr>
The Offset Dimension Text That Doesn’t Fit should be set to YES.
The Override Offset For Single Wall Placement should be set to NO.
Select: The box next to Omit Dimension @ Indicated Length.
Prompt: Width for dimension omission?:
Select: 3 1/2” from the Options menu above the prompt line.
Replace Existing Dimension should be set to YES.
Select: The box next to Search Type located in the bottom right corner of the Global Wall
Dimensioning pop-up menu.
Prompt: Search wall type?
Select: EXTLB from the Options menu above the prompt line.
Verify should be set to NO.
Select: Level located just above the Create button.
Select: Create.
Prompt: Perform described edit? DEF: YES NO
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Select: YES to confirm the command.
Select: The Display All icon to display the entire drawing in the display window.
BuildersCAD will dimension the plan as shown in Figure 5-4.

Figure 5-4

Next we want to lay down an additional string of dimensions, from outside wall corners to interior partitions.
Select: Drawing Tools on the Walls Application menu to display the Drawing Tools - Walls pop-up
menu.
Select: Global under the Dimension heading on the Drawing Tools - Walls pop-up menu to display
the Global Wall Dimensioning pop-up menu.
Select: Setup Global Dmn under the Place heading on the Global Wall Dimensioning pop-up
menu.
This will display the Global Wall Dimensioning Setups menu with the parameter settings you just set.
Select: The box under the center of the OPENING, turning off the highlight so that you will not
dimension the opening again.
Select: The boxes on both sides of the interior wall intersection at the top of the Global Wall
Dimensioning Setup menu causing both to highlight.

40

Sigma Design

Dimensioning the Floor Plan
Now we will be dimensioning from outside corners to both sides of interior partitions. Looking at the other
parameters:
Change the Dimension Offset to 3’6.
Change Overall Dimension to NO.
Toggle Replace Existing Dimension to NO.
Select: Create again.
Prompt: Perform described edit? DEF: YES NO
Select: YES from the Options menu above the prompt line.
BuildersCAD will generate another string of dimensions on each exterior wall.
Select: The Display All icon to display the entire drawing in the display window.
Your floor plan should now look like Figure 5-5.

Figure 5-5

SAVE THE DATABASE.
Next we want to add a dimension string on the interior wall separating the garage from the other two rooms.
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Select: Drawing Tools on the Walls Application menu to display the Drawing Tools - Walls pop-up
menu.
Select: Global under the Dimension heading on the Drawing Tools - Walls pop-up menu to display
the Global Wall Dimensioning pop-up menu.
Select: Wall Direction under the Place heading on the Global Wall Dimensioning pop-up menu.
We want to be sure we place the dimensions on the “right side” of the vertical interior wall. After you select
Wall Direction you will be prompted:
Prompt: Select wall to display (F10 Cancel)
Pick: the vertical interior wall using F1.
The wall will highlight in red and the words BEGIN, END, and OUT will appear on the right side of the wall. If
it appears on the left side, that’s OK too. Note which side of the interior wall BuildersCAD considers the
outside of the wall.
Prompt: Restore display? YES NO
Select: YES from the OPTIONS menu above the prompt line.
Select: The Stop sign icon on the User Toolbar to exit this routine.

Stop

Select: Drawing Tools on the Walls Application menu to display the Drawing Tools - Walls pop-up
menu.
Select: Global under the Dimension heading on the Drawing Tools - Walls pop-up menu to display
the Global Wall Dimensioning pop-up menu.
Select: Setup Global Dmn under the Place heading on the Global Wall Dimensioning pop-up
menu.
This will display the Global Wall Dimension Setup pop-up menu. Deselect all highlighted buttons in the
diagram at the top of the pop-up menu, turning them all to gray.
Across the diagram at the top of the pop-up menu, select the boxes on the interior edge of the BEG. WALL
and END WALL, and both sides of the INT. WALL.
Under Dimension Side, make sure Outside is highlighted. If the OUT designation appeared on the left side
of the vertical wall in the previous step, the Dimension Side should be set to Inside.
Dimension Offset should be set to 2’-0”.
Overall Dimension should be set to NO.
Offset Dimension Text That Doesn’t Fit should be set to YES.
Override Offset For Single Wall Placement should be set to NO.
Omit Dimension @ Indicated Length should be set to 3 1/2”.
Replace Existing Dimension may be set to either YES or NO.
Search Wall Type at the bottom right of the Global Wall Dimension Setup pop-up menu should be
set to ALL.
Select: Single above the Create Button.
Select: Create.
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Prompt: Select wall to dimension (F10 Cancel):
Pick the vertical interior wall.
BuildersCAD will generate a string of dimensions for the interior wall. Your floor plan should now appear
as shown in Figure 5-6.
Select: The Stop sign icon on the User Toolbar to exit this routine.

Stop

Figure 5-6

We have completed dimensioning the floor plan.
Tip: If you want to relocate any of the dimension text, see the Dimensions topic in the BuildersCAD
Encyclopedia.
SAVE THE DATABASE.
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Adding Text to the Floor Plan
To add text to the drawing:
Select: Drawing Tools on the Walls Application menu to display the Drawing Tools Walls pop-up
menu.
Select: The Text icon on the Drawing Tools pop-up menu.
This will cause the Text application sub-menu to display. Notice also that BuildersCAD has created a
layer number 1008 for text connected with Walls Level A.
We will add room labels with the text functions. When the Text application sub-menu appeared you may
have noticed that the Status menu across the bottom of the screen also changed.
Select: Size on the Status menu.
Select: .15 on the Sizes (Paper Units) pop-up menu.
Select: The Place Single Text icon under the Place heading on the Text Application submenu.
Prompt: Location for text (F10:exit):
Pick: A point with the F1 / left mouse button on the floor plan approximately the center of the garage
area.
Prompt: Enter text (Cntrl-E for menu):
Enter: GARAGE <cr>.
Prompt: Location for text (F10:exit):
Pick: A point with the F1 / left mouse button in the room in the upper left corner of the floor plan, just
above the door.
Prompt: Enter text (Cntrl-E for menu):
Enter: BATH <cr>.
Select: The Paragraph Text icon under the Place heading on the Text Application submenu.
Select: Justify on the Status menu.
Select: C in the Lower row under the One Point heading on the Text Justification Options pop-up
menu.
Prompt: Location for text:
Pick: A point with the F1 / left mouse button just above the center of the room in the lower left corner of
the floor plan.
Prompt: Enter text (Cntrl-E for menu):
Enter: WORK <cr>.
Enter: ROOM <cr>.
Enter: <cr> to finish the paragraph text.
Select: The Stop sign icon on the User Toolbar to exit this routine.
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Note: Another way to label the rooms is with the BuildersCAD Room Label feature. Select Drawing
Tools on the Walls Application menu. Under the Notation heading select Misc Labels and from the
pop-up menu select Place Room Labels. You will be able to box around rooms or outline a room,
point to point. After you define the area of the room you will be able to manually or automatically place
a room label (selecting from a menu). To find out more about the Room Label feature, see the
BuildersCAD Encyclopedia.
Select: Size on the Status menu.
Select: .25 on the Sizes (Paper Units) pop-up menu.
Select: The Place Single Text icon under the Place heading on the Text Application submenu.
Prompt: Location for text (F10:exit):
Pick: A point below the floor plan bottom horizontal dimension.
Prompt: Enter text (Cntrl-E for menu):
Enter: FLOOR PLAN <cr>.
Prompt: Location for text (F10:exit):
Select: the F10 key or the Stop sign icon on the User Toolbar to exit the routine.

Stop

Note: Again you can use the MISC LABEL feature, accessed through Drawing Tools to place a
drawing label.
The floor plan should now appear as shown in Figure 5-7 below.

Figure 5-7
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If you want to move the text around,
Select: The Edit icon on the Desktop menu (at the top of the screen, to the right of center).
This will display the Edit menu as shown in Figure 5-8 below.
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Figure 5-8

Select: The Text icon under the Entity Filter heading on the Edit menu (as highlighted in Figure 5-8
above).
Select: The Single Entity icon under the Search Method heading on the Edit menu (as highlighted
in Figure 5-8 above).
Select: Move under the Edit Action heading on the Edit menu.
Prompt: Move which text:
Pick any text. You will be prompted to select a Reference Point and a New Location for the text. Use these
move text tools to adjust the text locations as desired.
We have completed the Floor Plan. In the next chapter we will create a Foundation Plan.
SAVE THE DATABASE.
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6. Using Walls to Create a
Foundation Drawing
Introduction
Foundations is a feature in the Walls Application. When you create a Foundation Plan using this feature you
are creating a line drawing, not another level of foundation walls.
Foundation drawings cannot be viewed in 3D and they cannot be used to generate material takeoffs,
however this is a quick and easy way to generate a Foundation Plan. The Foundation drawing we create will
be based on the assumption that a footing with foundation wall will support the back portion of the structure
(Work Room and Bath), but the front (Garage) will be on a slab.

Creating a Foundation Drawing
Select: WALLS on the BuildersCAD Main Application menu to display the Place Walls Application
sub-menu.
Select: Edit Walls at the bottom of the Place Walls Application sub-menu. This will display the Edit
Walls and Edit Openings Application sub-menu.
Select: The Change Wall Lap icon.
Prompt: Select wall to change (F10 Cancel):
Pick: The interior vertical wall at each end.
This will change the wall laps on the vertical interior wall so that the interior panel looks as though it extends
to the exterior surface of the exterior walls. See Figure 6-1.
Note: You will find a brief discussion on Wall Laps in Chapter 4 of this tutorial, Entering Walls and
Openings. For more information on Laps, refer to the Layout portion of the Walls Application topic
in the BuildersCAD Encyclopedia.

Figure 6-1
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Select: Foundations on the Walls Application menu. This will display the Footings Application submenu.
Select: Display Foundation Layers on the Footings Application sub-menu. This will display the
Foundation Layers pop-up menu as shown in Figure 6-2.

Select:WallsontheFoundationLayerspop-upmenu.

Foundation Layers
Walls

Select: Display On on the Foundation Layers
pop-up menu.

Foundation Outlines
Dimensions
Miscellaneous

Select: Execute on the Foundation Layers
pop-up menu.

Notes
All
Level

A
Functions
Display On

Clear
Layer

Display Off
Execute
Figure 6-2

Select: Exterior Footings on the Footings Application sub-menu. This will display the Foundation
Wall Type pop-up menu as shown in Figure 6-3.
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Figure 6-3
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There are six styles available for drawing the exterior footings. Three show a foundation wall with footing
and three show a slab with footing.
Select: the Foundation Wall Type, third from the right along the top of the Exterior Footings pop-up
menu, as shown in Figure 6-3.
Select: The Overall Footing Width box under the Dimensions heading on the Exterior Footings
pop-up menu. See Figure 6-3.
Prompt: Enter overall width? CUR: 2’-0” 1’-4” 2’-0” OTHER
Select: 1’-4” on the Options menu above the prompt line.
Select: on the Wall Width box under the Dimensions heading on the Exterior Footings pop-up
menu. See Figure 6-3.
Prompt: Enter width? CUR: 0’-8” 0’-4” 0’-6” 0’-8” OTHER
Select: 0’-6” on the Options menu above the prompt line.
Select: on the Distance from the Wall to the Edge of the Footing under the Dimensions heading
on the Exterior Footings pop-up menu. See Figure 6-3.
Prompt: Enter width? CUR: 0’-4” 0’-4” 0’-6” OTHER
Select: 0’-4” on the Options menu above the prompt line.
Select: The box under the Placement Method heading on the Exterior Footings pop-up menu. See
Figure 6-3.
This will toggle the Placement Method between Search EXTLB Walls and manual. The Placement
Method should be set to manual.
Below the Placement Method on the Exterior Footings pop-up menu, the parameters should be set as
follows:
Direction should be set to counterclockwise.
Color should be set to 1.
Pen should be set to 1.
Level should be set to A.
Select: Place Footing on the Exterior Footings pop-up menu.
Prompt: Enter points until closure (F10 to end):
With the F11/right mouse button, pick the lower left corner and then using the F11/right mouse button, trace
around the exterior walls selecting the four points as shown in Figure 6-4. You must “draw” the outline in a
counter-clockwise direction.
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Point 4

Point 1

Point 3

Point 2
Figure 6-4

After you have picked the lower left corner of the wall layout for the second time (the fifth point), closing the
outline, BuildersCAD will draw the foundation outline as shown in Figure 6-5 below.

Figure 6-5
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Select: Exterior Footings on the Footings Application sub-menu to display the Exterior Footings
pop-up menu.
Select: The center Slab Footing Type, second from the left on the Exterior Footings pop-up menu.
Be sure the parameters are set as follows on the Exterior Footings pop-up menu:
Footing Width Dimension should be set to 1’-4”.
Dimension from slab edge to Outside of Footing should be set to 4”.
Placement Method should be set to manual.
Select: Place Footing at the bottom of the Exterior Footings pop-up menu.
Pick: The four points (again in a counterclockwise direction) as shown in Figure 6-6 using the
F11/right mouse button.

Point 4

Point 3

Point 2

Point 1
Figure 6-6

After you have picked the fourth point:
Pick: Any point using the F10/middle mouse button to exit the routine.
The foundation outlines should now appear as shown in Figure 6-7.
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Figure 6-7

Now go back to the Edit Wall Application sub-menu and change the internal vertical wall laps back to the
original setting, so they do not break the exterior walls. Refer back to the beginning of this chapter if you do
not remember how to do edit the wall laps.
SAVE THE DATABASE.

Dimensioning the Foundation Plan
We will now add some dimensions to our foundation plan.
Select: Foundations on the Walls Application menu. This will display the Footings Application submenu.
Select: Display Foundation Layers on the Footings Application sub-menu. This will display the
Foundation Layers pop-up menu as shown in Figure 6-2.
Select:FoundationOutlinesontheFoundationLayerspop-upmenu.
Select: Display On on the Foundation Layers pop-up menu.
Select: Execute on the Foundation Layers pop-up menu.
You are again looking at only the Foundation Outline layer.
Select: Drawing Tools on the Walls Application menu to display the Drawing Tools pop-up menu.
Select: The Dimension icon at the bottom of the Drawing Tools pop-up
menu. This will display the Dimensions Application sub-menu and Status
menu.
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First we will run a string of dimensions across the bottom of the Foundation Plan. On the Status menu at the
bottom of the screen, under Text Mode (TX MODE), the setting should be auto. If you see manual here,
select the box and it will toggle to auto.
Select: The Running Dimension icon on the Dimension Application sub-menu.
Prompt: First dimension point:
Pick the lower left corner of the foundation wall (not footing) outline using the F11/right mouse button.
See Point 1 in Figure 6-8 below.
Prompt: Next dimension point:
Pick the lower right corner of the foundation wall (not footing or slab line) outline using the F11/right
mouse button. See Point 2 in Figure 6-8 below.
Prompt: Position for dimension line:
Pick: A point 3 as shown in Figure 6-8 with the F1/left mouse button.

Point 1

Point 4

Point 2
Point 3

Figure 6-8

Tip: If the 3rd point you pick is too far to the left or right the dimension will not look as expected. You
should pick a point “directly below” the first point you picked.
Prompt: Next dimension point (F10:restart):
Pick: The lower right corner of the slab using the F11/right mouse button. See Point 4 in figure 6-8.
Prompt: Next dimension point (F10:restart):
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Pick: Any point using the F10/middle mouse button to stop the dimension string.
Pick: Any point using the F10/middle mouse button again or select the Stop icon on the
User Toolbar to exit the Running Dimension command.

Stop

You now have a string of dimensions on the Foundation Plan as shown in Figure 6-9.

Figure 6-9

We will now add a single overall dimension below the existing string and add a single overall dimension to
the right side of the foundation outline.
Select: The Single Dimension icon on the Dimension Application sub-menu.
Prompt: First point for dimension:
Pick the lower left corner of the foundation wall (not footing) outline using the F11/right mouse button.
See Point 1 in Figure 6-8.
Prompt: End point for dimension:
Pick the lower right corner of the slab line outline using the F11/right mouse button. See Point 4 in
Figure 6-8.
Prompt: Position for dimension line:
Pick: A point below the existing string of dimensions and directly below the first dimension point to
place the overall dimension string.
Prompt: First point for dimension:
Pick the lower right corner of the slab line outline using the F11/right mouse button.
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Prompt: End point for dimension:
Pick the upper right corner of the slab line outline using the F11/right mouse button.
Prompt: Position for dimension line:
Pick: A point to the right of the first point for this overall dimension, where the dimension line is to be
placed.
Select: The Stop sign icon on the User Toolbar to exit the routine.

Stop

The Foundation Plan should be as shown in Figure 6-10.

Figure 6-10

Note: You may want to use the ZOOM WIN feature to zoom the view in closer to make sure you select
the correct points for dimensioning.

Next we will add diagonal dimensions so the foundation subcontractor can insure the foundation is square.
Select: The button under the Align heading on the Status menu to toggle the Align setting to on.
Using the Single Dimension command as described above, add the diagonal dimensions shown in Figure
6-11. Use the F11/right mouse button to pick the points on the foundation and F1/left mouse button to pick
the location for the dimension strings.

BuildersCAD Tutorial

55

6. Foundation Drawing

Figure 6-11

SAVE THE DATABASE.

Adding Notes to the Foundation Plan
We will now add notes to the foundation plan drawing using the Notes Feature in BuildersCAD.
Select: Drawing Tools on the Walls Application menu to display the Drawing Tools pop-up menu.
Select: The NOTE icon under the Notation heading on the Drawing Tools pop-up
menu to display the Notes Application sub-menu and Status menu.
Select: The Select icon on the Notes Application Sub-menu. The Catalog
Note Placement pop-up menu will display. See Figure 6-12.

NOTE

SELECT

Select: The BuildersCAD Tutorial Notes category on the left side of the
Catalog Note Placement pop-up menu.
Select: The first note “HOLD DOWN TOP OF FOUNDATION WALL” on the
right side of the Catalog Note Placement pop-up menu.
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CATALOG NOTE PLACEMENT
CURRENT NOTE CATALOG
BuildersCAD Note Catalog
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Site Plan Notes
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Roof Notes
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Framing Notes
Mechanical Plan Notes
Plumbing Plan Notes
Electrical Plan Notes
BuildersCAD Tutorial Notes

Search
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Note
HOLD DOWN TOP OF FOUNDATION WALL
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GARAGE SLAB
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4” CORNER BOARD

Clear
Menu

Manual
Note

Preview
Note
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Figure 6-12

Select: The Place Note button at the bottom of the Catalog Note Placement pop-up menu. The
menu will clear from the screen and the cursor will form boxes the size of the note.
Select: The None button under the Left Leader heading on the Status menu at the bottom of the
screen.
Pick: A point near the upper left corner of the drawing using the F1 key. The selected note will be
placed in this location.
Repeat the above process to add the following notes:
FRAMED FLOOR THIS AREA
6” FOUNDATION WALL, TYPICAL
GARAGE SLAB
1’-4” FOOTING, TYPICAL
Note: For the notes with leaders, select the 2 Segment Leader button in the center under the Left
Leader heading on the Notes Status menu at the bottom of the screen. See Figure 6-13 below. When
placing the note, after the note text is placed, BuildersCAD will prompt for the bend point, then the
arrow point of the leader.

Caps Frame
ON
OFF

Mask
OFF

Note Type
TEXT

Left Leader
None

Right Leader
None

Figure 6-13

Place the notes in the locations shown in figure 6-14 on the next page.
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Figure 6-14

SAVE THE DATABASE.

We have now completed the Foundation Plan. In the next chapter we will place symbols (Parts) on the Floor
Plan.
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7. Placing Parts in the Floor Plan
Introduction
Most floor plans contain symbols, either hand drawn or created in a computer, which are used to represent
objects such as a bath tub, toilet, electrical switch, etc. BuildersCAD comes with several libraries of precreated symbols that you can select and place in a database.

Parts for the Floor Plan
Select: WALLS on the BuildersCAD Main Application menu to display the Place Walls Application
sub-menu.
Select: Level on the Status menu. This will display the Level Creation / Manipulation pop-up menu.
Select: The box containing A under the LVL heading on the Level Creation / Manipulation menu.
This will turn off all layers except the Level A walls layer (number 1001).
Select: Level Layers on the Level Creation / Manipulation menu. This will display the Additional
Wall Layer Modes pop-up menu.
Select: E under the Modes heading on the Additional Wall Layer Modes menu adjacent to the
following layers:
Wall Dimensioning
Wall Notes
Opening Labels
Select: Exit w/ Disp on the Additional Wall Layer Modes menu to clear the menu and redisplay the
screen. The plan should look like Figure 7-1.

Figure 7-1
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To get back to the BuildersCAD Application menu:
Select: Walls (The heading at the top of the Walls Application menu). This will toggle the Application
menu back to the BuildersCAD main menu.
Select: Parts. This will display the Parts Application menu, the Place Parts Application sub-menu,
and the Parts Status menu.
Select: The Select button on the Place Parts Application sub-menu. This will display the PART Select pop-up
menu.
Catalog
Type

1. Select the
PLUMBING box on
the left side of the
PARTS Select menu.

BuildersCAD Catalog
PLUMBING

APPLIANCE
CABINETS
ELECTRICAL
HVAC
MISCELLANEOUS
PLUMBING
UNUSED 1
UNUSED 2
UNUSED 3
UNUSED 4

2. Select the tub
from the matrix on
the right side of the
PARTS Select menu.
3. Select Exit at the
bottom of the PARTS
Select menu to
clear the menu
from the screen.

PARTS Select
Part Name
RI Name

tub
pt_tub

K-1201

K-1231

K-12458

K-1355

K-1569

K-2175-4

K-2221-8

K-3490

K-3544

K-515

K-519

K-713

K-770

K-785

hosebib

kitsink

shower

sink1

sink2

sink3

sink4

tub

tub1

tub2

waterhtr

Create

Edit

Place

Exit

Figure 7-2

Select: PLUMBING as the Part Type on the left side of the PARTS Select pop-up menu. This will
change the matrix on the right side of the menu to display the Plumbing parts.
Select: tub, near the bottom left of the matrix on the right side of the PARTS Select menu, as the
desired part.
Select: Exit at the bottom of the PARTS Select menu to clear the menu from the screen.
Select: Standard under the Placement Method heading of the Place Parts Application sub-menu.
The cursor will become an icon that looks like the plan view symbol of the tub.
Prompt: F1 to place r.i. (F10 for options):
Move the cursor (tub) to the upper left hand corner of the Bath, and position it in the wall niche.
Pick: With the F1/left mouse button to place the tub.
Note: You are placing the tub when it looks like it is positioned correctly. Exact placement in the corner
is not critical here. If you want to place the tub exactly in the corner you can do so using the New
Reference tool. See the Reference Points topic in the BuildersCAD Encyclopedia for more
information.

60

Sigma Design

Parts for the Floor Plan
Select: The Select button on the Place Parts Application sub-menu to redisplay the PART Select
pop-up menu.
Select: The Down Arrow icon at the lower right corner of the matrix on the right side of the
PART Select pop-up menu. This will page the matrix down to display more items.
Select: wc1 near the lower right corner of the matrix on the right side of the PARTS Select menu.
Select: Place at the bottom of the PARTS Select pop-up menu. The cursor will form in the shape of
the selected toilet.
Prompt: F1 to place r.i. (F10 for options):
Move the cursor to the outside wall of the Bath, below the tub to a point that looks correct and place the toilet
by picking the point using the F1/left mouse button.
Select: The Select button on the Place Parts Application sub-menu to redisplay the PARTS Select
pop-up menu.
Select: CABINETS as the Part Type on the left side of the PARTS Select pop-up menu. The Cabinet
Parts will display in the matrix on the right side of the pop-up menu.
Select: The Down Arrow icon at the lower right corner of the matrix on the right side of the
PART Select pop-up menu. This will page the matrix down to display more items. Select the
Down Arrow until you see the part VCB24.
Select: VCB24 in the matrix on the right side of the PARTS Select pop-up menu. This is a 24” Vanity
Base Cabinet.
Select: Place at the bottom of the PARTS Select pop-up menu. The cursor will form in the shape of
the selected vanity cabinet.
Setup

Prompt: F1 to place r.i. (F10 for options):
Pick: The F10 / middle mouse button to display the Setup popup menu as shown in Figure 7-3.
Select: The Up Arrow on the Select pop-up menu. This will
rotate the vanity cabinet 90 degrees. The Angle of Rotation
button in the center of the menu will show the angle of rotation
as 90.00, and the image of the cabinet on the menu will update
to show the cabinet rotated 90 degrees clockwise.

0.00

Select: Place at the bottom of the Setup pop-up menu. The
cursor will update to reflect the new rotation of the cabinet.

Rotation

We now have the vanity in the correct orientation to snap it into place in
the lower left corner of the bath.
Prompt: F1 to place r.i. (F10 for options):
Pick: The lower left corner of the bath using the F11 / Right
mouse button.
Select: The Stop sign icon on the User Toolbar to exit
the routine.

Stop

This completes the Floor Plan. Your plan should now look like Figure
7-4.
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Figure 7-3
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Figure 7-4

SAVE THE DATABASE.

Place Parts to Create the Electrical Plan
Through the Layer menu or through the Walls Level Creation / Manipulation menu, turn off the wall
dimensioning (number 1006), wall notes (number 1008), and opening labels (number 1009) layers. For the
start of the Electrical Plan you should have the walls, plumbing symbols, and cabinet symbols layers on for
edit, select, and display.
Select: The Select button on the Place Parts Application sub-menu. This will display the PART Select pop-up
menu.
Select: Electrical as the Part Type on the left side of the PARTS Select pop-up menu. This will
change the matrix on the right side of the menu to display the Electrical parts.
You will use the Parts exhstfan2, light1, light6, outlet2, switch, and switch3.
Select and place each part. Use the Standard and Snap commands under the Placement Methods
heading on the Place Parts Application sub-menu to place these parts so that the plan looks similar to
Figure 7-5.
Note: The Snap command places the part directly on the wall near the cursor, placing the part using
the F1 / left mouse button.
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Figure 7-5

To add connectors to the Electrical Plan:
Select: Electrical Connectors under the Placement heading of the Parts main menu. This will
display the Line Type application sub-menu.
Select: The box below the Line Type heading on the Line Type Application sub-menu. This will
display the Arc Line Types pop-up menu as shown in Figure 7-6 below.

Arc Line Types

User
Figure 7-6

Select the dash-dot line type.

Select: The dash-dot line type (right side in the middle) on the Arc Line Types pop-up menu.
Select: Place Arc Line under the Connector heading on the Line Type Application sub-menu.
Prompt: First point (F10 to exit):
Pick: The end of a switch using the F11 / right mouse button.
Prompt: Next point (F10 to restart):

BuildersCAD Tutorial

63

7. Placing Parts in the Floor Plan
Pick: A point approximately midway between the switch and the fixture you are going to connect the
switch to, midway but not in a straight line, using the F1 / left mouse button.
At this point the cursor will appear white and act like a “rubber band”.
Prompt: Next point (F10 to restart):
Pick: A point on the end of the fixture you are connecting using the F11 / right mouse button.
The connector will become fixed in place and turn red (or the color of the Electrical Parts).
Prompt: Next point (F10 to restart):
Pick: Any point using the F10 / middle mouse button. The command will go back to the First Point
prompt and you are ready to enter another connector.
Repeat the process until connectors have been added to all switches and the two lights near the back of the
garage have been connected. Your plan should appear similar to Figure 7-7.

Figure 7-7

To complete the Electrical Plan we need to add a couple of text labels.
With the Part Type, Electrical displayed as the current part type on the Status menu:
Select: Drawing Tools on the Parts main Application menu to display the Drawing Tools pop-up
menu.
Select: The Text icon on the Drawing Tools menu. This will display the Text Application
sub-menu and Status menu.
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Select: The box under the Size heading on the Status menu. This will display the Sizes (Paper
Units) pop-up menu.
Select: .10 on the Sizes (Paper Units) pop-up menu. The Status menu will display .10 as the current
text size.
Add the 2 text labels GARAGE DOOR as shown on the plan in figure 7-8 below. When this is complete,
change the text size to .20 and add the title ELECTRICAL PLAN below the wall layout.

Figure 7-8

The Electrical Plan is now complete.
SAVE THE DATABASE.
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8. Creating and Framing Floor Planes
Introduction to Floors
When you create a “floor” with BuildersCAD you are actually creating a floor plane. A floor plane is a
surface that can be opaqued (colored in so that it appears as a solid on the display window), or it can be
“framed” by the BuildersCAD Framer. A floor plane can also be utilized by the Materials Application to
generate a material takeoff.
Floor planes are not necessary to create a set of working drawings. If you are not using BuildersCAD to
generate framing and/or material takeoffs, you may want to skip this chapter.
You must create at least one floor plane to utilize the Materials Application for floors. Also you must create
floor planes to use the BuildersCAD Framer to create a Floor Framing Plan and/or generate a framing
lumber takeoff.
In this tutorial we assume that the floor of the rear portion of the “garage”, the Work Room and Bath, is
supported by foundation walls instead of a slab. Therefore it requires a wood floor system.

Creating a Floor Plane
Select: Layers on the Desktop menu at the top of the screen to display the Layer Pop-up menu.
Select: D in the under the Modes heading in the OFF row for All Layers at the bottom of the column.
This will turn off all layers.
Select: Exit & Display at the bottom right of the Layer menu to clear the menu and redisplay the
screen.
Select: Floors on the BuildersCAD main Application menu. This will
display the Floors Application menu, the Floor Geometry Application submenu, and the Floors Status menu.
Select: The box under the Floor Level heading on the Status menu. This will display the Floor Level
Creation / Manipulation pop-up menu.
Select: The first box under the LVL heading on the Floor Level Creation / Manipulation pop-up
menu. This will turn on Floor Level A.
Select: The first box under the Description heading on the Floor Level Creation / Manipulation
pop-up menu.
Prompt: New level description? CANCEL
Enter: Work Area <cr> (or any description you would like).
Select: Re-Display on the Floor Level Creation / Manipulation pop-up menu to clear the menu
from the screen.
On the Status menu you will see the Floor Level (A), the Level Description (Work Area), the Wall Level
(A), and a display under the Walls heading that indicates whether or not the walls are turned on for display.
Walls should be turned on to use for reference to draw the floor plane outline. We are now ready to create a
floor plane.
Select: Add Plane on the Floor Geometry Application sub-menu. This will display the Add Plane
pop-up menu as shown in Figure 8-1.
The information on the Add Plane pop-up menu includes the following:
Plane Number - The number of the plane you are about to create.
Pitch - Horizontal indicates a flat plane.
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Base Elev - The elevation of the floor plane. The bottom of the bottom plate of first floor walls is
typically 0’-0”.
Color - The color used to display the floor plane you are about to create.
You can select from three commands available to create a
floor plane outline, Run, Box, or Trace. You would use Run
to outline an irregular shaped area, Box to outline a square
or rectangular shaped area, and Trace to automatically
trace around the perimeter of the exterior walls to define a
floor plane. In this tutorial, we will be creating a simple
rectangular floor plane.

Add Plane
Level
A
Plane
1
Pitch
Horiz
Base Elev
0”
Color
49
Commands

Select: The Box icon under the Commands heading
on the Add Plane pop-up menu.
Figure 8-1

Prompt: First point of box (F10 to exit):
Pick: The outer lower left corner of the wall layout (point 1 as shown in Figure 8-2 below) using the F11
/ right mouse button.

Point 2

Point 1

Figure 8-2

Prompt: Second point of box. (F10 to exit):
Select: New under the Ref heading on the Cycle menu.
Prompt: New reference point:
Pick: The point 2 indicated in Figure 8-2 above, where the back inside wall of the garage meets the
top exterior wall, using the F11 / right mouse button. This sets the reference point at point 2.

68

Sigma Design

Creating a Floor Plane
The actual point desired for the second corner of the floor plane is along the outside wall, even with the
garage side of the vertical wall dividing the garage from the bath and work room. By setting the new
reference to a pick-able point along the inside of the wall, the second corner may now be entered by
entering the known distance from the new reference to the desired point.
Prompt: Second point of box (F10 to exit):
Enter: ,3.5” <cr>
After the second point of the rectangular area has been entered, BuildersCAD will prompt to verify the
creation of the floor plane.
Prompt: Create closure and add plane? DEF: yes redraw exit
Select: yes on the options menu above the prompt line. The floor plane outline will blink and highlight
in the designated floor plane color.
Prompt: Select edge perpendicular to framing:
Pick: Along one of the “vertical” floor plane edges, for example along the interior wall that runs
vertically on the display window, using the F1 / left mouse button.
An arrow will be displayed as shown in Figure 8-3. This arrow indicates the direction of the floor joists if you
decide to frame the floor. In this example, the joists will run horizontal on the screen, parallel to the short
walls of this floor plane.

Figure 8-3

The floor plane has been created and can now be utilized by the BuildersCAD Framer for framing the
floor and the Materials Application for generating a material takeoff.
SAVE THE DATABASE.
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Framing the Floor
We will now use the BuildersCAD Framer to frame the floor plane we have just created.
Select: The Edges button under the 3D Boards heading on the Floors Application menu to display the Edge
Boards Application sub-menu.
Select: The Assign Markers button under the Markers heading on the Edge Boards Application sub-menu. This
will display the Floor Board Specification pop-up menu.

Floor - Board Specification
A
Level
Parameters
Available Boards
Description
Text Size
.2
Entry
f.b102
Pen
3
(2) 2x10 Beam
Color
5
(3) 2x10 Beam(Drp)
f.b123
f.ej10
2x10 End Joist
Piece Specification
f.fj10
2x10 Floor Joist
12” Floor Truss
f.fltr
Overrides
f.h102
(2) 2x10 Header
Behavior
DEFAULT
f.hd10
2x10 Header
End 1 CT B
DEFAULT
f.msej
2x6 Mud Sill End
End 2 CT B
DEFAULT
Floor
Edge
Type
for
Selected
Boards
C
l
Rough
Any
e
Rim
End
Lap
Opening
Type
a
r

Selected Boards

1
2
3
4
Edit Function
Level

Plane

Area

Execute
Single

Erase

Place

Figure 8-4

The Markers you assign to the plane edges contain information (”framing rules”) about the boards to
generate on each plane edge (size of board, number of board[s], location of board relative to the plane
edge).
In the upper right corner of the Floor-Board Specification pop-up menu is a list of the Available Boards
(all of the “framing rules” that determine board parameters). Below this under the Floor Edge Type for
Selected Boards heading is a row of the various types of floor plane edge types: Any Type, Rim, End,
Lap, and Rough Opening. Below each edge type is a blank column.
Select: End under the Floor Edge Type for Selected Boards heading. The box will highlight.
Select: 2x10 End Joist from the Available Boards list.
Select: Rim under the Floor Edge Type for Selected Boards heading. The box will highlight.
Select: 2x10 Rim Joist from the Available Boards list. You will have to scroll the list down to find
and select this board.
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Select: Level under the Edit Function heading on the Floor - Board Specification pop-up menu.
Select: Place under the Execute heading on the Floor - Board Specification pop-up menu. The
edges of the floor plane will highlight.
Prompt: Add/change floor line markers? DEF: yes no
Select: yes on the Choice menu above the prompt line. Markers will appear pointing to the edges of
the floor plane. See Figure 8-5.

Figure 8-5

BuildersCAD recognizes End edges perpendicular to the edge selected for floor framing orientation. Rim
edges are parallel to the baseline.
Select: Generate Edge Boards under the Boards heading on the Edge Boards Application submenu.
Prompt: Generate edge joists? LEVEL PLANE SINGLE CANCEL
Select: LEVEL on the Choice menu above the prompt line.
Select: The button under the Walls heading on the Status menu to toggle the walls to OFF.
Select: The Re-Display icon on the View Control Bar to redisplay the screen.
You should see the edge joists and markers as shown in Figure 8-6.
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Figure 8-6

The next task is to generate the floor joists.
Select: Surf’s under the 3D Boards heading on the Floors Application menu. This will display the
Surfaces Application sub-menu.
Select: The Assign Markers button on the Surfaces Application sub-menu. This will display the
Floor Surface Marker Specifications pop-up menu as shown in Figure 8-7 below.

Floor Surface Marker Specification
Name
Desc
Joist to use
Spacing
Joist Offset
Boards Offset
Sheathing Spec
Text Size
Color
Pen

NONE
1’-4”
AUTO
0
NONE
.2
13
4

Entry
2x10-12
2x10-24
2x10-16
FlrTrs-24
TJI-24

Level
A
Marker Specifications
Description
2x10 Joist - 12” OC
2x10 Joist - 24” OC
2x10 Joist - 16” OC
Flr Truss - 24” OC
Truss Joist - 24” OC

Operational Commands
New

Save

Clear

Remove

Place

Figure 8-7

Select: 2x10-16 (2x10 floor joists spaced at 16” OC). Joists generated by this Marker will “fill” the floor
plane.
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Select: Place under the Operational Commands heading on the Floor Surface Marker
Specification pop-up menu.
Prompt: Position for surface marker F10 to exit:
Move the cursor to the middle of the floor plane and pick using the
F1 / left mouse button. The edge boards with the surface marker
should appear as shown in Figure 8-8.
Prompt: Position for surface marker F10 to exit:
Pick: Any point using the F10/middle mouse button to exit the
placement command.

Next we will generate the actual floor joists to fill the floor plane.
Select: Generate Boards under the Boards heading on the
Surfaces Application sub-menu.
Prompt: Surfaces to fill? LEVEL
CANCEL

SINGLE

AREA

Figure 8-8

Select: Area on the Choice menu above the prompt line.
Prompt: Select desired surface marker F10 to exit:
Pick: The Surface Marker on the floor plane with the F1 / left
mouse button.
Prompt: Point within boundary to begin <F10> exit:
Pick: The lower left corner of the edge boards with the F11 /
right mouse button.
Prompt: Beginning offset in inches? DEF:0 3 6 OTHER
Enter: 16 <cr>
Prompt: Point within boundary to end <F10> exit:
Pick: The upper left corner of the edge boards with the F11 /
right mouse button.
Prompt: Ending offset in inches? DEF:0 3 6 OTHER
Enter: 12 <cr>
BuildersCAD will now generate the floor joists as shown in
Figure 8-9.
Figure 8-9

SAVE THE DATABASE.
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The Floor Framing Plan
To create a Floor Framing Plan, first confirm that the Floor Level is A on the Status menu.
Select: 2D Board Layout on the Floors Application menu to display the Layout Application submenu and Status menu.
Select: Extract Dashed Walls at the bottom of the Layout Application sub-menu. BuildersCAD
will display the Make Dashed Walls pop-up menu as shown in Figure 8-10.

Make Dashed Walls
Color
1
Pen
1

Level
Search
Level

A
ALL
A

Create Dashed Walls
Figure 8-10

Select: Create Dashed Walls at the bottom of the Make Dashed Walls pop-up menu.
2D dashed walls with the floor boards will be displayed and should look like Figure 8-11.

Figure 8-11

SAVE THE DATABASE.

74

Sigma Design

The Floor Framing Plan
The feature we are about to use will generate piece marks and a cut list for the floor boards.
Select: Reports under the 3D Boards heading of the Floors Application menu. This will display the
Reports Application sub-menu.
Select: Label Boards under the Labeling heading on the Reports Application sub-menu. This will
display the Board Label Setup pop-up menu as shown in Figure 8-12.

Place Board Labels
Place Member List
Print Member List
Save Member List

Board Label Setup
Label Planes
YES
Pen
YES
Text Size
NO
Color
NO
Floor Level

NO
1
.07
11
A

Create Board Labels
Figure 8-12

Toggle or set the following:
Place Board Labels should be set to YES.
Place Member List should be set to YES.
Print Member List should be set to NO.
Save Member List should be set to NO.
Label Planes should be set to NO.
Pen should be set to 1.
Text Size should be set to .07.
Color should be set to 11.
Floor Level should be set to A.
After completing the setup of parameters on the Board Label Setup pop-up menu:
Select: Create Board Labels on the Board Label Setup pop-up menu.
The BuildersCAD Framer will label each of the boards, label the plane, and generate a Member List
(each board label listed with an exact cut length). When the Framer labels the boards and generates the cut
list it turns off all layers except the 2D floor boards. After the boards are labeled, BuildersCAD will prompt:
Prompt: Place member list (F10 to exit):
Pick: A point to place the list, to the right of the framed floor with the F1 / left mouse button.
Select: The Layer button on the Desktop menu at the top of the screen to display the Layer pop-up
menu.
On the left side of the Layer pop-up menu, scroll down until you see layer number 1421 (the layer name is
fl_fadw). Turn this layer on for edit, search, and display by selecting the E.
Select: Exit and Display at the bottom of the Layer menu. The result should be a labeled plan similar
to Figure 8-13.
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Figure 8-13

To complete the Floor Framing Plan, we will add a string of dimensions and a title.
Select: Drawing Tools on the Floors Application menu to display the Drawing Tools pop-up menu.
Select: The Dimension icon at the bottom of the Drawing Tools pop-up
menu to display the Dimension Application sub-menu and Status menu.
Use the Dimensions tools to add dimensions to the Floor Framing Plan. Also use the Text feature from the
Drawing Tools pop-up menu to add the title FLOOR FRAMING PLAN to the plan as shown in Figure 8-14.
If you don’t remember how to use the Dimension and Text tools, refer to Chapter 5, Wall Dimensions and
Text.

Figure 8-14

SAVE THE DATABASE.
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9. Creating and Framing Roof Planes
Introduction to Roofs
When you create a “roof” with BuildersCAD you are actually creating a system of roof planes. A roof plane
is a surface that can be opaqued (colored in so that it appears as a solid on the display window), or it can be
“framed” by the BuildersCAD Framer. A roof plane can also be utilized by the Materials Application to
generate a material takeoff.
Roof planes are utilized by BuildersCAD to generate Elevations. The roof as created in the Roofs
Application determines the location of the eave edge, also the height and location of the ridge, hip, and
valley edges.
The “framed” roof is utilized in generating a Roof Framing Plan. The boards that the BuildersCAD Framer
creates for a material takeoff can be dimensioned, and notes added to serve as a Roof Framing Plan.

Creating a Roof
A Roof is made up of a system of roof planes. To create a roof plane system:
Select: Roofs on the BuildersCAD Main Application menu. This will
display the Roofs Application menu, the Roofs Application sub-menu, and
the Roofs Status menu.
Select: The box under the Roof Level heading on the Status menu. This will display the Roof Level
Creation / Manipulation pop-up menu.
Select: The first box under the LVL heading on the Roof Level Creation / Manipulation pop-up
menu. This will turn on Roof Level A.
Select: The first box under the Description heading on the Roof Level Creation / Manipulation
pop-up menu.
Prompt: New level description? CANCEL
Enter: Garage Roof <cr> (or any description you would like).
Select: Re-Display on the Roof Level Creation / Manipulation pop-up menu to clear the menu from
the screen.
On the Status menu you will see the Roof Level (A), the Roof Elevation, Eave Marker, Class, Roof,
Soffit, Wall Level, and Walls (allows you to toggle Wall display ON and OFF). Roof Level indicates the roof
level that is current or the one you are about to create. The Elevation is the relative elevation
BuildersCAD will use for any outline you input. The other settings will be discussed later.
Select: The Zoom All icon on the View Control Bar to redisplay the screen.
The walls will provide reference points for creating the roof system outline. On the Roofs Application menu,
the Roof Geometry button will be highlighted. The tools to draw or outline the area you will cover with the
roof are under the Perimeter heading on the Roofs Application sub-menu.
Select: The Box icon under the Perimeter heading on the Roofs Application sub-menu.
Prompt: First point of box (F10) Cancel:
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On the message line: Outline will be added to roof a - 8’-1 1/8” elevation will be used
Note: On the Status menu the Elevation displayed is the elevation of the outline you are about to
create. Since you selected Walls Level A and the default wall height on Level A is 8’-1 1/8” in height,
the elevation default elevation is 8’-1 1/8”.
If the elevation displayed is different, select Elevation on the Status menu. BuildersCAD will prompt for
the new value. Type 8’1 1/8” <cr> to set the elevation.
Since the building we want to put a roof on is a simple box, pick the lower left, outside corner of the wall
layout with the F11 / right mouse button, as shown by Point 1 in Figure 9-1.
Prompt: Second point of box (F10) Cancel:
Pick: The upper right outside corner of the wall layout as shown by Point 2 in Figure 9-1 using the F11
/ right mouse button.
Point 2

Point 1

Figure 9-1

Prompt: Add another box? Yes No
Select: No on the Choice menu above the prompt line.
You will see the outline around the outside edge of the wall layout.
Select: Setup under the Eave Properties heading on the Roof Application sub-menu. This will
display the Define Eave pop-up menu as shown in Figure 9-2.
Under the Eave Styles heading on the Define Eave pop-up menu, scroll down until the 8/12-6 eave style is
displayed.
Select: 8/12-6 under the Eave Styles heading on the Define Eave pop-up menu. 8/12-6 will display
in the left portion of the pop-up menu as the Name of the current Eave Marker and on the Status
menu under Eave Marker. The parameters for this marker will display on the left side of the Define
Eave pop-up menu.
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Define Eave
Name
8/12-6
Desc
8/12-2x6
1
No of Slopes
8/12
Pitch (Rise/12)
33.7
Pitch (Deg)
Rafter
Method
3 1/2”
Seat Cut
4 1/4”
Heel Height
Rafter Depth
5 1/2”
Overhang
1’-0”
Soffit Offset
5”
Marker Size
0.375
Marker Color
20
Level

All on Roof

Single Eave

Name
6/12-6
6/12-8
6/12-T
7/12-6
7/12-8
7/12-T
8/12-12
8/12-6
8/12-8
8/12-T
8/12-TJ14
New

Eave Styles
Description
6/12-2x6
6/12-2x8
6/12-T
7/12-2x6
7/12-2x8
7/12-T
8/12-2x12
8/12-2x6
8/12-2x8
8/12-T
8/12-14” TJI
Save

Clear

Delete

Figure 9-2

Select: The Single Eave button along the bottom of the Define Eave pop-up menu.
Prompt: Select outline for marker (F10 to Cancel):
Pick: Each of the two horizontal outline lines using the F1 / left mouse button.
Note: On the display window, all layers will turn off except the roof outline.
Roof Markers will appear as shown in figure 9-3.

Figure 9-3
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Select: Setup underthe EaveProperties headingofthe RoofsApplicationsub-menutodisplaythe DefineEave popupmenu.
On the Define Eave pop-up menu, under the Eave Styles heading, scroll to the bottom of the list.
Select:gableundertheEaveStylesheadingontheDefineEavepop-upmenu.
Select:SingleEaveontheDefineEavepop-upmenu.
Prompt:Selectoutlineformarker(F10toCancel):
Pick: Each of the two vertical outline lines using the F1 / left mouse button.
Prompt:Selectoutlineformarker(F10toCancel):
Pick: Any point using the F10 / middle mouse button to exit the routine.
The outline with Markers assigned will look like Figure 9-4.

Figure 9-4

The perimeter of the roof has been defined and each edge now has a Marker to define the roof plane which
projects up from it. To actually generate the roof planes:
Select: 3D under the Generate Roof heading on the Roofs Application sub-menu.

3D
Prompt: Make planes? def: all roof cancel
Select: all on the Choice menu above the prompt line.
BuildersCAD will “make” the roof planes based on the information in the Markers. Your screen should
now look like Figure 9-5.
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Figure 9-5

To look at an isometric view of the 3D roof you just created:
Select: The Isometric View icon on the View Control Bar. The isometric view of the roof
you just created should look like Figure 9-6.

Figure 9-6
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The roof geometry is now complete and you are ready to frame the roof.
Select: The Plan View icon on the View Control Bar to return the display to plan view.
SAVE THE DATABASE.

Quick Roof
In the first part of this chapter we manually outlined the roof and assigned Eave Markers, then generated the
roof planes to create the roof. We wanted to show you how to use these features of the Roofs Application.
There is however another easier way to create this roof using the Quick Roof tool. Quick Roof is especially
useful if all of the roof edges use the same Marker (all roof planes have the same parameters).
With BuildersCAD you can generate an alternate roof plane system for your floor plan. Each one resides
on a different Level. We just created a roof on level A and now we will use the Quick Roof tool to create a roof
on Level B.
Select: The Roof Level box on the Status menu to display the Roof Level Creation / Manipulation
menu. This menu is shown in Figure 9-7.

Roof Level Creation / Manipulation
Description
LVL
Garage Roof
A

Layers
ON
OFF
OFF
OFF
OFF
OFF
OFF
OFF
OFF
OFF

Utilities
Level
Layers

Clear
Level

All
Layers

Re-Display

Figure 9-7

Select: The box under A in the LVL column on the Roof Level Creation / Manipulation menu.
Prompt: New level description?
Enter: Quick Roof <cr>
Select: Re-Display at the bottom of the Roof Level Creation / Manipulation menu to clear the menu
from the screen.
Select: The Roof Geometry button at the top of the Roofs Application menu if it is not highlighted
already.
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Select: The Quick Roof button on the Roofs Application sub-menu. This will
display the Quick Roof pop-up menu as shown in Figure 9-8. Set the roof
parameters as shown in Figure 9-8 and as listed below.

Quick Roof
No. of Slopes
Pitch (Rise/12)
Pitch (Deg)
Method
Seat Cut
Heel Height
Rafter Depth
Overhang
Soffit Offset
Elevation

QUICK
ROOF

1
8/12
33.7
Rafter
3 1/2”
4 1/4”
5 1/2”
1’-0”
6”
8’-1 1/8”

Figure 9-8

No. of Slopes should be set to 1.
Pitch (Rise/12) should be set to 8/12.
Pitch (Deg) will adjust automatically.
Method should be set to Rafter.
Seat Cut should be set to 3 1/2”.
Heel Height will adjust automatically.
Rafter Depth should be set to 5 1/2”.
Overhang should be set to 12” (1’-0”).
Soffit Offset should be set to 6”.
Elevation should remain at the default of 8’-1 1/8”.
Select: The Wall Trace button at the bottom of the Quick Roof pop-up menu.
Prompt: Clear current roof level? Yes No
Select: Yes on the Choice menu above the prompt line.

BuildersCAD will outline the walls, assign the markers, and generate the roof planes.
The Wall Trace button told BuildersCAD to find the exterior load bearing walls and use them to define the
roof outline. Also BuildersCAD will use them to set the elevation of the outline and if the walls are raked
(Remember we raked the end walls when we entered them in Chapter 4) BuildersCAD will generate a
gable on that wall.
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This is a very quick and easy method to generate a roof plane system. Keep in mind that the Wall Trace only
works if you want the walls to define the roof outline (no porch overhangs) and if you rake the walls where
you want gables.
Select: The Roof Level box on the Status menu to display the Roof Level Creation / Manipulation
menu.
Select: The box containing A under the LVL column on the Roof Level Creation / Manipulation
menu.
Select: The Re-Display box at the bottom of the Roof Level Creation / Manipulation menu to clear
the menu from the screen.
SAVE THE DATABASE.

Framing the Roof
We will now generate the framing for the roof A we have created.
Select: Edges under the 3D Boards heading on the Roofs Application menu. This will display the
Edge Boards Application sub-menu.
Select: Assign Markers under the Markers heading on the Edge Boards Application sub-menu.
This will display the Roof-Board Specification pop-up menu as shown in Figure 9-9 below.

Roof - Board Specification
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Level
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Figure 9-9
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The Markers you assign to the plane edges contain information (”framing rules”) about the boards to
generate on each plane edge (size of board, number of board[s], location of board relative to plane edge).
In the upper right corner of the pop-up menu you see a list of the Available Boards (all of the “framing rules”
that determine board parameters) and below the list of boards you see a heading Roof Edge Type for
Selected Boards. Below this heading is a row of the various types of roof plane edge types: Any Type,
Fascia, Ridge, King, Hip, Valley, Rough Opening, Tier and Gable. Below each edge type is a blank
column.
Select: Ridge under the Roof Edge Type for Selected Boards heading on the Roof-Board
Specification pop-up menu. The box will highlight.
Select: The Down Arrow under the Available Boards list to scroll down the list until you see the 2x8
Ridge Board.
Select: 2x8 Ridge Board from the Available Boards list.
Select: Fascia under the Roof Edge Type for Selected Boards heading on the Roof-Board
Specification pop-up menu. The box will highlight.
Select: The Up Arrow under the Available Boards list to scroll up the list until you see the 1x6 Eave
Fascia.
Select: 1x6 Eave Fascia from the Available Boards list.
Select: Gable under the Roof Edge Type for Selected Boards heading on the Roof-Board
Specification pop-up menu. The box will highlight.
Select: 1x6 Gable Fascia from the Available Boards list.
Select: Level under the Edit Function heading on the Roof-Board Specification pop-up menu.
Select: Place under the Execute heading on the Roof-Board Specification pop-up menu. The
edges of the roof will highlight.
Prompt: Add/Change roof line markers? DEF: yes no
Select: yes on the Choice menu above the prompt line.
A Marker will be assigned to the Ridge, Eave Fascias, and Gable Fascias as shown in Figure 9-10.

Figure 9-10
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Select: Generate Edge Boards under the Boards heading near the bottom of the Edge Boards
Application sub-menu to create the edge boards.
Prompt: Generate edge joists? Level Roof Single Cancel
Select: Level on the Choice menu above the prompt line. BuildersCAD will generate the 2D edge
boards.
SAVE THE DATABASE.

To complete the roof framing:
Select: Surf’s under the 3D Boards heading on the Roofs Application menu. This will display the
Surfaces Application sub-menu.
Select: Assign Markers on the Surfaces Application sub-menu. This will display the Roof Surface
Marker Specification pop-up menu as shown in Figure 9-11 below.

Level
Roof Surface Marker Specification
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2x6 RAFTERS 16” OC
2x4 OUTLOOKER
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r.cr06
2x6 RAFTERS 16”OC
2x6-16
Spacing
1’-4”
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Boards Offset
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2x8-12
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2x8 RAFTERS 12”OC
r.rd12
2x8 RAFTERS 16”OC
2x8-16
Text Size
0.8
2x8-24
Color
2x8 RAFTERS 24”OC
13
COLLAR TIE 16”OC
CT-16
Pen
4
Operational Commands
New

Save

Clear

Place
Remove

Place

Place

Figure 9-11

Select: 2x6-16 under the Surface Marker Specifications heading on the Roof Surface Marker
Specification pop-up menu.
Select: Single under the Place heading on the Roof Surface Marker Specification pop-up menu.
Prompt: Position for surface marker F10 exit:
Pick: A point in the middle of each roof plane using the F1 / left mouse button. Markers will appear and
your roof will look like Figure 9-12.
Pick: Any point using the F10 / middle mouse button to exit the Marker placement command.

86

Sigma Design

Framing the Roof

Figure 9-12

Select: Generate Rafters under the Boards heading on the Surfaces Application sub-menu to
create the rafters.
Prompt: Surface to fill? LEVEL MODULE SINGLE AREA CANCEL
Select: Area on the Choice menu above the prompt line.
Prompt: Select the desired surface marker F10 to exit:
Pick: The Surface Marker inside the roof plane on the lower half of the display window.
Prompt: Point within boundary to begin (F10) exit:
Pick: The lower left outside corner of the edge boards with the F11 / right mouse button.
Prompt: Beginning offset in inches? DEF: 0 3 6 OTHER
Enter: 12.75” <cr>
Prompt: Point within boundary to end (F10) exit:
Pick: The lower right outside corner of the edge boards using the F11 / right mouse button.
Prompt: Ending offset in inches? DEF: 0 3 6 OTHER
Enter: 12.75” <cr>
The BuildersCAD Framer will generate rafters as shown in Figure 9-13.
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Figure 9-13

Follow the same procedure starting by selecting Generate Rafters under the Boards heading on the
Surfaces Application sub-menu, and generate the rafters for the roof plane in the upper half of the screen.
Rafters should appear as in Figure 9-14

Figure 9-14

SAVE THE DATABASE.
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We will now generate the roof decking.
Select: Generate Sheathing under the Sheathing heading on the Surfaces Application sub-menu.
Prompt: Surface fill method? EDGE LOCATION SINGLE ROOF LEVEL CANCEL
Select: Edge Location on the Choice menu above the prompt line.
Prompt: Select desired surface marker F10 exit:
Pick: The surface marker of one of the roof planes using the F1 / left mouse button.
Prompt: Board to locate edge (F10 to Cancel):
Pick: The third board from the left edge.
BuildersCAD will generate the 4x8 roof decking to cover the roof plane. Repeat the steps to generate the
sheathing in a similar way on the other roof plane. When finished, your roof should look like Figure 9-15.

Figure 9-15

SAVE THE DATABASE.

The Roof Framing Plan
We will now create a Roof Framing Plan.
Select: 2D Board Layout on the Roofs Application menu. This will display the Layout 2D Framing
Application sub-menu.
Select: Extract Dashed Walls near the bottom of the Layout 2D Framing Application sub-menu.
BuildersCAD will display the Create Dashed Walls pop-up menu as shown in Figure 9-16.
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Create Dashed Walls
Color
1
Pen
1

Level
Search
Level

A
ALL
A

Create
Figure 9-16

Select: Create on the Create Dashed Walls pop-up menu.
Select: Layer on the Desktop menu at the top of the screen. This will display the Layer pop-up menu.
Turn on layers 1407 edge joists 2D (rf_raej), 1408 roof joists 2D (rf_rarj), and 1414 2D dashed walls
(rf_radw) for Edit, Search, and Display. All other layers should be turned off.
Select: Exit & Display at the bottom of the Layer menu to clear the menu and redisplay the screen.
The 2D dashed walls with the roof boards displayed should look like Figure 9-17.

Figure 9-17

Now we will generate piece marks and a cut list for the roof boards.
Select: Reports under the 3D Boards heading on the Roofs Application menu. This will display the
Reports Application sub-menu.
Select: Label Boards under the Labeling heading on the Reports Application sub-menu. This will
display the Board Label Setup pop-up menu as shown in Figure 9-18.
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The Roof Framing Plan

Place Board Labels
Place Member List
Print Member List
Save Member List

Board Label Setup
Label Planes
YES
Pen
YES
Text Size
NO
Color
NO
Floor Level

YES
1
.09
11
A

Create Board Labels
Figure 9-18

Toggle or set the following:
Place Board Labels should be set to YES.
Place Member List should be set to YES.
Print Member List should be set to NO.
Save Member List should be set to NO.
Label Planes should be set to YES.
Pen should be set to 1.
Text Size should be set to .09.
Color should be set to 11.
Floor Level should be set to A.
After completing the setup of parameters on the Board Label Setup pop-up menu:
Select: Create Board Labels on the Board Label Setup pop-up menu.
The BuildersCAD Framer will label each of the boards, label the plane, and generate a Member List
(each board label listed with an exact cut length). When the Framer labels the boards and generates the cut
list it turns off all layers except the 2D roof boards. After the boards are labeled, BuildersCAD will prompt:
Prompt: Place member list (F10 to exit):
Pick: A point to place the list, to the right of the framed floor with the F1 / left mouse button.
Tip: You might want to use the Zoom Out feature so you will be able to see the Member List.
Select: The Layer button on the Desktop menu at the top of the screen to display the Layer pop-up
menu.
On the left side of the Layer pop-up menu, scroll down until you see layer number 1414 (the layer name is
rf_radw). Turn this layer on for edit, search, and display by selecting the E.
Select: Exit and Display at the bottom of the Layer menu. The result should be a labeled plan similar
to Figure 9-19 on the next page.

SAVE THE DATABASE.
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Figure 9-19

To complete the Roof Framing Plan, we will add a few dimensions and a title.
Select: Drawing Tools on the Roofs Application menu to display the Drawing Tools pop-up menu.
Select: The Dimension icon at the bottom of the Drawing Tools pop-up
menu to display the Dimension Application sub-menu and Status menu.
Use the Dimensions tools to add dimensions to the Roof Framing Plan. Also use the Text feature from the
Drawing Tools pop-up menu to add the title ROOF FRAMING PLAN to the plan as shown in Figure 9-20. If
you don’t remember how to use the Dimension and Text tools, refer to Chapter 5, Wall Dimensions and
Text.

Figure 9-20

SAVE THE DATABASE.
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10. Creating Elevations
Introduction
BuildersCAD utilizes the walls (with openings) you have entered and the roof you have created when an
Elevation is generated. The first step in creating an Elevation is to let BuildersCAD generate the
“construction lines”. Then you use crosshatch patterns (that look like shingles or siding), notes, and
dimensions to detail out the Elevation drawing.

Create the Front Elevation
To create a Front Elevation of the tutorial building:
Select: Elevations on the BuildersCAD Main Application menu. This will
display the Elevations Application menu, the Elevation Setup Application
sub-menu, and the Elevation Status menu.
Select: Front on the Elevations Application menu. This will display the Elevation Application submenu.
Select: Level Select on the Elevation Application sub-menu. This will display the Elevation
Creation pop-up menu as shown in Figure 10-1 below.
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H
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J
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Figure 10-1

On the Elevation Creation pop-up menu, be sure the boxes for Level A next to the Wall Surface and Wall
Opening features are highlighted. The box for All (Levels) as well as the box for each individual Level A-J
may be highlighted as shown in Figure 10-1.
The box for Level A only should be highlighted for the Roof Surfaces feature as shown in Figure 10-1 above.
The settings for the individual Levels or All for the various features may be toggled on and off by selecting
the box on the grid for the Feature and Level desired.
Select: Create Elevation at the bottom of the Elevation Creation menu.
The walls will appear on the display window, then the wall display will change to an isometric view of the 2D
walls. The exterior surface of the walls will extrude in 3D. When the program finishes this step you will be
looking at a front view of the “wire frame” model with door and window symbols.
Prompt: Option? Create FRONT Elevation
Layer
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Select: Create FRONT Elevation on the Choice menu above the prompt line.
The system will create the Front Elevation. When finished, the Front Elevation construction lines will be as
shown in Figure 10-2.

Figure 10-2

To add the opening (door) symbol,
Select: Doors under the Custom Tools heading of the Elevations Application menu to display the
Door / Window Application sub-menu.
Select: The Select button on the Doors / Windows Application sub-menu. This will display the
Repeated Item Select pop-up menu as shown in Figure 10-3 below.
Select: The door symbol you wish to use. We are going to use the symbol ie_d11.
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Preview
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Place
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Figure 10-3
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Select: The Place button at the bottom right of the Repeated Item Select pop-up menu.
Prompt: Lower left corner (F10 Cancel):
Pick: The lower left corner of the door opening on the elevation using the F11 / right mouse button.
Prompt: Upper right corner (F10 Cancel):
Pick: The upper right corner of the door opening on the elevation using the F11 / right mouse button.
The door symbol will be added as shown in Figure 10-4.

Figure 10-4

Select: The F10 key or the Stop sign button on the User Tool Bar to terminate the RI
placement routine.

Stop

We will use Drawing Tools to add “siding trim” such as corner boards.
Select: Drawing Tools at the bottom of the Elevations Application menu to display the Drawing
Tools Elevation pop-up menu.
Select: The Lines icon in the upper left corner under the Draw heading on the Drawing
Tools Elevation to display the Lines Application sub-menu.
Select: The Lines / Curves Tools icon in the bottom left corner of the Lines Application
sub-menu to display the Lines / Curves Tools pop-up menu.
Select: The Offset Line / Curves icon on the Lines / Curves Tools pop-up menu. This
tool will create a parallel line a specific distance (or offset) from a selected line.
Prompt: Offset Distance: cur: 1’-0” EXIT
Enter: 4” <cr>
Prompt: Point on correct side of line/wall/curve (F10: restart):
Pick: The “wall line” on the left side of the elevation using the F1 / left mouse button. Be sure to pick
with the cursor slightly to the right (inside) side of this line as shown by Point 1 in Figure 10-5.
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Point 2

Point 1

Figure 10-5

Prompt: Point on correct side of line/wall/curve (F10: restart):
Pick: The “wall line” on the right side of the elevation using the F1 / left mouse button. Be sure to pick
with the cursor slightly to the left (inside) side of this line as shown by Point 2 in Figure 10-5.
We have now added “corner boards” to the Front Elevation.

You may have noticed a vertical line just to the left and right of both ends of the building. These are lines
created by an end view of the 2D opening symbols of the openings on each end of the building. To erase
these lines:
Select: The Edit icon on the Desktop menu at the top of the screen. This will display the Edit pop-up
menu.
The Entity Filter should be set to LINES (The “L” icon to the left of the Circle icon).
The Search Method should be set to Area In.
Select: The Erase icon (The icon with the red X) under the Edit Actions heading on the Edit pop-up
menu as shown in Figure 10-6.
Prompt: 1st fence point for erase of lines (F10: options):
To erase the lines, carefully window around the vertical lines outside the building at each end. If you
inadvertantly include other lines and they are erase, select the Undo button on the desktop menu at the top
of the screen and try again.
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Figure 10-6

To add siding to the Front Elevation,
Select: Surface under the Custom Tools heading on the Elevation Application menu. This will
display the Surfaces - Siding Group 1 Application sub-menu.
Select: The Siding box on the Surfaces - Siding Group 1 Application sub-menu.
Prompt: Width? 4” 5” 7” 10” OTHER

siding

Select: 5” on the Choice menu just above the prompt line.
Prompt: Boundary method? Def: end box point to point end
Select: box on the Choice menu just above the prompt line.
Prompt: First box point:
Pick: The lower left inside corner of the corner board on the left side of the elevation using the F11 /
right mouse button (Point 1 in Figure 10-7).
Prompt: Second box point:
Pick: The upper right inside corner of the corner board on the right side of the elevation using the F11 /
right mouse button (Point 2 in Figure 10-7).
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Point 2
Point 1

Figure 10-7

Prompt: Boundary method? Def: end box point to point end
Do Not select end.
Select: box on the Choice menu just above the prompt line. You will now be defining areas within the
area you just defined where you Do Not want the siding to go.
Prompt: First box point
Pick: The lower left corner of the door using the F11 / right mouse button as shown by Point 1 in Figure
10-8 below.
Prompt: Second box point
Pick: The upper right corner of the door using the F11 / right mouse button as shown by Point 2 in
Figure 10-8 below.

Point 2
Point 1

Figure 10-8
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Follow the same procedure to box around the windows to exclude the windows from being covered with
siding. After you have boxed around both windows:
Prompt: Boundary method? Def: end box point to point end
Select: end on the Choice menu just above the prompt line.
Siding (pattern) will fill the wall area excluding the door and windows. Your drawing should now look like
Figure 10-9.

Figure 10-9

SAVE THE DATABASE.

To add shingles to the roof:
Select: Roof on the Surfaces - Siding Group 1 Application sub-menu to display the Surfaces - Roof
Surfaces Application sub-menu.
Select: Shingle under the Roof Surfaces heading on the Surface - Roof Surfaces
Application sub-menu.

shingle

Prompt: Roof Slope? 3/12 4/12 5/12 6/12 7/12 8/12 OTHER
Select: 8/12 on the Choice menu just above the prompt line.
Prompt: Boundary method? Def: end box point to point end
Select: box on the Choice menu just above the prompt line.
Prompt: First box point:
Pick: The lower left corner of the roof surface (not the bottom of the fascia board) with the F11 / right
mouse button.
Prompt: Second box point:
Pick: The upper right corner of the roof surface with the F11 / right mouse button.
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Prompt: Boundary method? Def: end box point to point end
Select: end on the Choice menu just above the prompt line.
A shingle pattern will fill the roof surface as shown in Figure 10-10.

Figure 10-10

SAVE THE DATABASE.

We will now add a few notes to the elevation.
Select: Drawing Tools at the bottom of the Elevations Application menu to display the Drawing
Tools pop-up menu.
Select: The NOTE icon under the Notation heading on the Drawing Tools pop-up
menu to display the Notes Application sub-menu and Status menu.
Select: The Select icon on the Notes Application Sub-menu. The Catalog
Note Placement pop-up menu will display.

NOTE

SELECT

Select: The BuildersCAD Tutorial Notes category on the left side of the Catalog Note Placement
pop-up menu.
Select: The note “SHINGLES” on the right side of the Catalog Note Placement pop-up menu.
Select: The Place Note button at the bottom of the Catalog Note Placement pop-up menu. The
menu will clear from the screen and the cursor will form boxes the size of the note.
Select: The 2 Segment button under the Left Leader heading on the Status menu at the bottom of the
screen.
Pick: A point above the roof in the drawing using the F1 key. The selected note will be placed in this
location. BuildersCAD will prompt for a bend point for the leader. Pick a point to the left of the note
text. Next pick a point on the roof for the arrow point.
Repeat the above process to add the note “4” CORNER BOARDS”.
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Select: The Text icon under the Notation heading on the Drawing Tools pop-up menu
to display the Text Application sub-menu and Status menu.
Select: The Single Text icon under the Place heading on the Text Application Sub-menu.
Select: Size on the Status menu.
Select: .20 on the Sizes (Paper Units) pop-up menu.
Prompt: Location for text (F10:exit):
Pick: A point approximately in the middle and below the elevation with the F1 / left mouse button.
Enter: FRONT ELEVATION <cr>.
Select: The Stop sign icon on the User Toolbar to exit this routine.

Stop

The elevation should now look like Figure 10-11.

Figure 10-11

Select: Drawing Tools on the Elevations Application menu to display the Drawing Tools pop-up
menu.
Select: The Dimension icon at the bottom of the Drawing Tools pop-up
menu to display the Dimension Application sub-menu and Status menu.
Use the Single Dimension tool to add a dimension from the bottom of the wall to the bottom of
the roof overhang. Your elevation drawing should look like Figure 10-12.
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Figure 10-12

The Front Elevation is now complete.
SAVE THE DATABASE.
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11. Materials Application
Introduction
Materials in a BuildersCAD Material Report may include framing lumber generated by the
BuildersCAD Framer in the Walls, Roofs, or Floors Applications. It may include a list of stock items
attached to a BuildersCAD Part (graphic symbols), i.e. when you place a bath tub you could cause the
Materials Application to take off a bath tub, shower valve, and towel bar. Finally materials on a Materials
Report may include material “applied” to the BuildersCAD database by the Materials Application.
In this Tutorial you will have material from all three sources. In this chapter we will first go through the
process of running a Pull List, on the Walls, Floor, and Roof you have already framed. This is a list of the
nominal lengths of lumber you need to frame the Tutorial structure.
Next you will “apply” materials to the walls, roof, floor, etc. using the default material setups.
Finally you will run a report that includes the framing lumber, the materials that you applied and materials
linked to the Parts you placed earlier when creating the floor plan.

Running a Pull List
Select: Materials on the BuildersCAD Main Application menu. This will
display the Materials Application menu.
Reports
Materials

Select: Materials under the Reports heading on the Materials
Application menu to display the Reports Materials Application submenu as shown in Figure 11-1.
Select: Pull List on the Reports Materials Application sub-menu.
Prompt: Destination? SCREEN EXTERNAL EDITOR DISK FILE
PRINTER CANCEL

Materials
Report
Quantities
Report
Pull
List
Cutting
Report

Pick: SCREEN on the Choice menu just above the prompt line as the
destination for the Pull List data.

BuildersCAD will generate a Pull List and display the data in a pop-up menu
as shown in Figure 11-2 on the next page. The Slide Bar to the right side of the
menu as well as the Half Page Down and Half Page Up buttons will allow you to
page through the data on the pop-up menu display. Select the Exit button to
clear the pop-up menu from the screen.

Figure 11-1

Note: The Pieces with no usage rules was generated for the Header Shims for the garage doors
because the BuildersCAD Framer could not cut 9 foot long header shims out of 8 foot long sheets
of plywood. For more information, see the Wall Framing portion of the Walls topic and the Materials
topic of the BuildersCAD Encyclopedia.
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Pull List Report

Half Page Down

Half Page Back

Exit

******************************************************************************
PULL LIST - WALLS LEVEL A
*
*
PAGE: 1 *
* RUN: 04/22/2002
JOB: tutorial *
* REVISED: 05/27/94
USER: C:\bcad\jlb\ *
* RUN: 16:30:27
******************************************************************************
PART #
=========
065084
065093
065098
065107
069901
060078
060080
065201
065203
065221
065229
065228
065222
065224
065225
065226

DESCR
SIZE
QTY USED QTY/COST
COST/UNIT COST
========== ============= ========= =========== ========== ========
#2 SYP
2X6 8’
5/EA
0.0/MBF
0.00/MBF
0.00
#2 SYP
2X8 8’
1/EA
0.0/MBF
0.00/MBF
0.00
#3 SYP
2X10 10’
2/EA
20.0/LFT
0.00/LFT
0.00
#3 SYP
2X12 10’
4/EA
0.1/MBF
0.00/MBF
0.00
DRYWALL
01/2X48 8’
44/SHE
44.0/SHE
0.00/SHE
0.00
PLYWOOD
01/2X48 8’
1/SHE
1.0/SHE
0.00/SHE
0.00
SHEATHING 01/2X48 8’
31/SHE
1.0/SHE
0.00/SHE
0.00
SPF
2X4 10’
30/MBF
0.2/EA
0.00/EA
0.00
SPF
2X4 12’
2/EA
0.0/MBF
0.00/MBF
0.00
SPF
2X4 14’
19/EA
0.2/MBF
0.00/MBF
0.00
STUD GRD S 2X4 7’ 8-5/8”
84/EA
0.4/MBF
0.00/MBF
0.00
STUD GRD S 2X4 8’
36/EA
0.2/MBF
0.00/MBF
0.00
STUD GRD S 2X4 10’
6/EA
0.0/MBF
0.00/MBF
0.00
STUD GRD S 2X4 12’
3/EA
0.0/MBF
0.00/MBF
0.00
STUD GRD S 2X4 14’
10/EA
0.1/MBF
0.00/MBF
0.00
STUD GRD S 2X4 16’
4/EA
0.0/MBF
0.00/MBF
0.00
-------0.00

Figure 11-2

How Materials Works
Every piece of material that BuildersCAD can include in a Material Report exists in a Stock File in the
Materials Application. All of the Estimating Formulas used to generate a Material Report exist in an
Estimating Formula File. Every line in an Estimating Formula takes a stock item (from the Stock File) and
calculates an application rate. BuildersCAD uses Templates to link Estimating Formulas (that are
applying specific materials) to the BuildersCAD model (the database you just created).
For example if you look in the Stock File you will find a stock item called 8” Hardboard Siding with a unique
stock item number. In the Estimating Formula File is a formula called 8” HB SIDING 7” REVEAL that
calculates how many linear feet of siding are needed to cover a square foot of wall surface area. There is a
Template called SURFACE 1st that you can use to “apply” this Estimating Formula to the BuildersCAD
database. When you run a Material Report the Material Application calculates the total linear footage of
siding needed for the building, based on the total square footage of exterior wall surface area.
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Applying Materials
Applying Materials
Select: Quick Apply near the top of the Materials Application menu to display the Quick
Application pop-up menu as shown in Figure 11-3.
Quick Application
Templates
Wall
Surface
Corner
Opening
Roof
Ceiling
Floor
Misc.
Markers
Color
Pen
Text Size
Show Length

5
1
0.06
NO

Schedule
Color
Pen
Text Size
Placement

6
1
0.15
AUTO

Create Markers and Schedules
Figure 11-3

Select: Surface on the Quick Application pop-up menu.
Prompt: Template to use? CUR: MENU NONE
Select: MENU on the Choice menu above the prompt line to display the Templates pop-up menu.
Select: SURFACE 1st on the Templates pop-up menu. The Quick Application pop-up menu will
return with SURFACE 1st filled in the box next to Surface.
Select: Opening on the Quick Application pop-up menu.
Prompt: Template to use? CUR: MENU NONE
Select: MENU on the Choice menu above the prompt line to display the Templates pop-up menu.
Select: OPENINGS on the Templates pop-up menu. The Quick Application pop-up menu will
return with OPENINGS filled in the box next to Opening.
Select: Roof on the Quick Application pop-up menu.
Prompt: Template to use? CUR: MENU NONE
Select: MENU on the Choice menu above the prompt line to display the Templates pop-up menu.
Select: ROOF/CORN on the Templates pop-up menu. The Quick Application pop-up menu will
return with ROOF/CORN filled in the box next to Roof.
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11. Materials Application
Select: Floor on the Quick Application pop-up menu.
Prompt: Template to use? CUR: MENU NONE
Select: MENU on the Choice menu above the prompt line to display the Templates pop-up menu.
Select: FLOOR 1st on the Templates pop-up menu. The Quick Application pop-up menu will return
with FLOOR 1st filled in the box next to Floor.
Select: Create Markers and Schedules on the Quick Application pop-up menu.
You will see Markers being applied to the wall surfaces (Figure 11-4), to the openings (Figure 11-5), to the
roof you created (Figure 11-6), and to the floor (Figure 11-7). The Markers will only appear momentarily as
the Materials Application applies the estimating formulas to the building. If you want to see the labels you
can turn them on through the Layer menu.

Figure 11-4
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Figure 11-5
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11. Materials Application

Figure 11-6
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Run a Material Report

Figure 11-7

Run a Material Report
Now you have boards generated by the BuildersCAD Framer in the Walls, Roofs, and Floors
Applications, materials attached to Parts already placed in the Floor Plan and Electrical Plan, and materials
applied to the Tutorial database in the Materials Application.
To run a Material Report:
Select: Materials under the Reports heading on the Materials Application menu to display the
Reports Materials Application sub-menu.
Select: Materials Report on the Reports Materials Application sub-menu. This will display the
Materials Report pop-up menu and the Template Names pop-up menu.
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11. Materials Application
Note: In this case the word Template refers to a Material Report Style. Templates here have no
connection to Templates that link Estimating Formulas to the BuildersCAD model (database).
Select: Purchase_Order on the Template Names pop-up menu. PURCHASE_ORDER will appear
as the Report Template in the Materials Report pop-up menu as shown in Figure 11-8.

Materials Report
Report Template

PURCHASE_ORDER

Field Sort
1.
2.
3.
4.
5.
6.
-

Output Options

Package
Item Number
Item Description
QTY of Purchased Unit
Cost / Unit
Extension
Category
QTY of Costed Unit
QTY of Used Unit
Subcategory
Subpackage

PACKAGE
Sort
Include Levels
ALL
ROUNDED
Part Rounding
Page Breaks
NONE
Display Subtotals
BOTH
Title Block
YES
Quantity Rounding
2
YES
Include Boards
YES
Include Parts
Include Stairs

Output

Include QTY Unit Fields
Costed Unit Field
Purchased Unit Field
Used Unit Field

N/A
N/A
N/A

User Defined Field
Insert After Field

N/A
N/A

Destination
File Name
Field Delimiter

Screen
N/A
N/A

Template Commands
Save

Save As

Delete

Create Report

Cancel

Figure 11-8

Notice that under the Output Options heading, near the bottom of the column on the right side of the menu,
you see entries Include Boards and Include Parts. Both are set to YES which indicates that when you run
this “style” report (use this Template name) boards from the BuildersCAD Framer and materials attached
to Parts that are placed in the database will be included in the Material Report.
Under the Output heading, set the Destination to Screen to review the report in a menu on the screen,
External Editor to review the report in the default external text editor such as Notepad or Wordpad, or
Printer to send the report to your default printer.
Select: Create Report at the bottom of the Materials Report pop-up menu. BuildersCAD will
generate the Materials Report. In our example, we have set the Destination under the Output
heading on the Materials Report pop-up menu to Screen to generate the report output to an onscreen menu as shown in Figure 11-9.
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MATERIALS REPORT

Half Page Down

Half Page Back

Exit

******************************************************************************
PURCHASE_ORDER - WALLS LEVEL A
*
*
PAGE: 1 *
* RUN: 04/22/2002
JOB: tutorial *
* REVISED: 05/27/94
USER: C:\bcad\jlb\ *
RUN:
16:30:27
*
******************************************************************************
LEVEL: ALL
PACKAGE: ITEM #
------------

DESCRIPTION
---------------------------------

COST/UNIT
COST
-------------------24” VANITY BASE (CENTER BOWL)
0999
111330
0.00 EA
0.00
0999
150032
22” END SPLASH
0.00 EA
0.00
Subpackage (CABINET) total: 0.00
Package (0999) total:
0.00
2005
2005

060084
3/4” T&G PLYWOOD
0.00
0.00 SHEET
070028
1/2” DOW FOAM BOARD
0.00
0.00 SHEET

# PURCHASED
---------------

1.00 EA
1.00 EA

5.00 SHEET
26.00 SHEET

Subpackage (1FRM) total: 0.00
Package (2005) total: 0.00
2100

060088
7/16”X4X8 OSB
0.00
0.00 SHEET

27.00 SHEET

Figure 11-9

Use the Slide Bar on the right side of the pop-up menu or the Half Page Down and Half Page Up buttons to
scroll through the Material Report.
As you review the Material Report you will notice that BuildersCAD groups material by a Package and
Sub-Package number. Package and sub-package for each material item is set in the Estimating Formula for
applied materials and materials attached to Parts. Lumber or boards generated by the BuildersCAD
Framer are automatically set to package BOARDS. The sub-package is determined by whether the boards
came from the Walls, Roofs, or Floors Application and what Level the boards came from. For example
boards generated by framing the Walls on Level A would report in sub-package WALLS - LEVEL A.
There is a message at the very end of the report: WARNING: Some pieces are not accounted for - Run
pull list for details. This message is generated when some pieces on the Pull List have been reported
under the Pieces with no piece rules message. Remember the 1/2” thick by 9 foot long header shims (for the
garage door headers) were reported under Pieces with no piece usage rules.
We have now completed generating a Pull List and a Materials Report using the Materials Application.
SAVE THE DATABASE.
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